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DISCLAIMER 

The software program Extreme Loading® for Structures and all associated documentation 

include trade secrets and are proprietary products of Applied Science International, LLC. The 

software products and documentation are furnished by Applied Science International, LLC 

under a software license agreement that contains provisions concerning term, payments, 

installation, restrictions, publications, responsibilities, ownership, copying, confidentiality 

and liability. This license agreement is included with the software package. The software 

product and documentation may only be used, disclosed, or transferred in accordance with 

this license agreement. 
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1 Introduction 

1.1 About ELS Viewer 

The Extreme Loading® for Structures (ELS) Viewer is part of the ELS software 

package, which consists of 3 programs: the Modeling Environment (ELS Modeler), 

the ELS Solver – utilizing the Applied Element Method (AEM), and the Results 

Viewer (ELS Viewer). Figure 1-1 illustrates the main functions of each part and its 

location in the big picture. Note that the ELS Viewer only opens files with the (*.aem) 

extension created by the ELS Solver.  

 

Figure 1-1 Components of the ELS Software  

1.1.1 System Requirements and Installation 

ELS Viewer is installed as part of the ELS package and does not have a separate 

installation procedure. For more information on system requirements and 

installation of the ELS package see the ELS Quick Start Guide.  

 

1.1.2 Running ELS Viewer 

The ELS Viewer can be opened in two ways; either directly from the operating 

system or from within the ELS Modeling Environment. To open it from ELS 

Modeler, choose Postprocessing >Open Extreme Loading Results Viewer or click its 

corresponding toolbar button ( ).  

You cannot open ELS Viewer from ELS Modeler except after at least one 

analysis step has been executed by ELS Solver on the *.els input file.  

 

 

ELS Modeler

• Define material types and 
properties

• Define structural component 
details

• Model structure geometry

• Apply loads to model

ELS Solver

• Generates elements and 
springs for problem

• Analyzes the problem 
using AEM

• Writes output files 

ELS Viewer

• View and animate 
structure displacements

• Analyze results using 
charts, contours, and 
Straining actions diagrams

• Export chart data, bitmaps, 
videos, and many other 
output formats

http://www.appliedscienceint.com/
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1.1.3 ELS Viewer Features 

The ELS Viewer is a state-of-the-art graphical user interface that enables you to view 

structural models with realistic appearance and behavior. It also provides you with 

powerful tools for analyzing simulation results and presenting them afterwards. 

Below is a list of the ELS Viewer features: 

Model View– below are the many viewing features of ELS 

 3D views from any direction. 

 Walkthrough mode. 

 Model clipping for viewing the hidden parts. 

 Any model object can be displayed or hidden 

 Model elements can be viewed in solid, wireframe, or shrink modes. 

 View spring states. 

Charts – you can perform the following with charts 

 Plot data for any data variable against any other variable (including time and 

loading increments). 

 Manage chart and series display options. 

 Export chart data. 

 Differentiate and integrate any chart data.  

Contour Diagrams – you can draw four types of contour diagrams 

 Stress/Strain contours can have their values calculated in global and principal axes 

directions or custom vectors. You can plot them on structure surfaces or cross-

sections. 

 Kinematic property contours can be drawn for displacement, velocity, 

acceleration, or rotation.   

 Blast pressure contours on structure surfaces. 

 OpenFOAM pressure on Structure objects. 

Straining Actions Diagrams – Straining actions diagrams have the following features 

 Draw normal, shear, bending moment, section rotation and torsion diagrams at 

the same time for different structure parts. 

 Draw Straining actions envelopes. 

 Straining actions values are calculated automatically for sections along columns 

and girders having automatic mesh. 

 Calculation of straining actions for custom components.    

Eigen Analysis – you can view vibration analysis results 

 View and animate vibration mode shapes (Eigenvectors). 

 View vibration frequencies or periods, and plot their changes in charts resulting 

from variation in structure stiffness. 

 Add differentiate and integrate for the chart. 
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Animation – you can view variations in the following simulation results with respect to 

time and loading increments  

 Structural displacements 

 Straining actions diagrams 

 Eigen modes 

 Charts 

 Contours 

Output Formats – you can export output in many file formats: bitmaps, videos, DXF, STL, 

Script from opened charts and OBJ format. 

1.2 About this Manual 
This section describes how the manual is organized and briefly mentions used 

typographical conventions. 

1.2.1 Manual Organization 

Chapters 2 and 3 explain the ELS Viewer workspace: 

 Chapter 2 introduces the different screen components of the program and lists 

commands accessible from the menus and toolbars. 

 Chapter 3 explains the use of the browser pane, which is an important component 

of the workspace used to control the display of different analysis results.   

Chapters 4 to 7 discuss the different model viewing features: 

 Chapter 4 explains model navigation operations like zooming, panning, and 3D 

viewing. 

 Chapter 5 explains advanced model navigation features like clipping and 

walkthrough modes together with customizing view settings like lighting, colors, 

transparency, and drawing sizes. 

 Chapter 6 explains the different viewing features of elements, springs, and 

boundaries. 

 Chapter 7 discusses different indicators used for displaying advanced analysis 

results such as element velocity, contacts, cracks, and blasts. It also explains the 

use of Control Bar in animating the results.   

Chapters 8 to 11 explain tools useful in the advanced analysis of results: 

 Chapter 8 explains how to create and export charts.  

 Chapter 9 explains how to create contours and manage their display. 

 Chapter 10 explains how to view Straining actions diagrams.  

 Chapter 11 explains how to view structure vibration analysis results.  

Chapters 12 and 13 explain the different features of exporting output, whether 

Images, videos or DXF file formats and markers. 
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1.2.2 Typographical Conventions 

For clarity, special text formatting is given to names of different types of screen 

elements when explaining the user interface. These special formats are listed below: 

 

 

1.3 Important ELS Terminology 

Before reading this manual, you must first understand some ELS and AEM related 

terms like springs, matrix and steel elements, and output frames. Doing so will 

enable you to get the most benefit from the ELS software and better understand 

analysis results.  

Springs – are objects which are generated by the ELS Solver for use in the AEM 

analysis. Their name comes from the fact that they behave like actual springs in the 

AEM theory and hold the elements together. There are two ways to view springs. In 

the first one the springs are defined according to their materials. They could be 

concrete, steel,……or brick. In the other way, the springs are defined by their type, 

either matrix springs (concrete, mortar, brick,……) or reinforcement springs or 

implicit springs. All straining actions, stress, or strain calculations are calculated by 

using these spring objects. Note that link members are also treated as springs having 

only normal force. For more information on springs see the ELS Theoretical Manual.      

Object Formatting Style Example(s) 

Title names of menus, browsers, and dialog 

boxes are written with the first letter 

capitalized. 

 … the Color Settings dialog 

box 

Names of menu commands, toolbar icons, and 

dialog box components are written in italics. 

 … choose the Save command  

 … click the Apply button 

Text which the user is asked to write in text 

boxes and keyboard keys are formatted in a 

typewriter font and between angled brackets. 

 … type <9 ft>in the textbox 

 … press the <Shift> key 

When referring to a menu command, a right 

arrow symbol is used to indicate its location 

within a menu or a sub-menu. 

 … choose File > Export >Image 

http://www.appliedscienceint.com/
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Elements – are generated by the ELS Solver for use in the AEM analysis. Structural 

components are converted to elements connected by springs in the AEM analysis. 

All components are converted to small elements called Matrix Elements except some 

types of steel sections which are converted to Steel Elements. This depends on the 

way steel was modeled in the ELS Modeler, as implicit or explicit steel. For more 

information on element generation and implicit and explicit steel, see the ELS 

Theoretical Manual. 

Frames – are units which hold the output analysis results. Each frame includes 

details about the structure at a particular time instance or load increment.  Charts, 

contours, and straining actions can all be displayed at the different frames. Playing 

the simulation results views the structure shape in consecutive frames. Frames are 

numbered sequentially starting from 1 upwards.  

1.4 Getting Help 

This section mentions all the sources of help available for the ELS Viewer in specific 

and the ELS package as a whole. You can obtain information through online help, 

printed documentation, and ASI technical support. 

1.4.1 Online Help 

The following explains the built-in help features provided with ELS: 

 Tool tips: they identify the various buttons and tools in the modeling 

environment. Tool tips are activated when you hover your mouse cursor over a 

button. 

 Help window: click the Help menu> Help command or click the  button to open 

the Help window, or press <F1> on your keyboard, while ELS is active. This help 

provides topics for all graphical user interface elements and steps to perform main 

program operations like viewing charts. You can browse the different topics by 

using the table of contents, index list, or search option.  

 Context-sensitive help: clicking the Help button in an active dialog box or 

pressing the <F1>key while in a dialog box, browser, or in an open menu opens 

the corresponding help page of this element. 

 Video Tutorials: these movies offer step-by-step procedures on how to perform 

different operations and access different features by using the ELS graphical user 

interface.  
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1.4.2 ELS Documentation Set 

Several manuals and guides are available in the ELS documentation set, each with a 

different focus: 

 Quick Start Guide – introduces both the ELS Modeler and ELS Viewer. It includes 

installation steps and simple step-by-step examples on how to define a problem, 

run the solver, and then view results.  

 Viewer Manual– gets you acquainted with the ELS Viewer and explains in detail 

all the tools available for analyzing, viewing, and exporting results.  

 ELS Theoretical Manual– provides theoretical background for the Applied 

Elements Method and the way different types of analyses are performed. 

 ELS Blast Manual— helps the user to clear the explosive load (Blast Load and 

Custom Blast load) and provides them with several Blast test cases 

 User Defined Material Modeling Manual- provides how to create new user defined 

material and explain all its properties.  

 

1.4.3 Technical Support 

Applied Science International (ASI) is committed to providing you with the best 

overall product experience. Hence, our products are designed with superior quality 

and ease of use in mind, but we understand that issues do arise from time to time 

that need the backing of our support resources. 

For details about the different support offerings, please visit the ASI website: 

www.appliedscienceint.com. To contact our technical support via email, use 

the email posted at the website. For installation issues and telephone support, please 

call us at (919) 645-4090 or Fax (919) 645-4085.  
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2 The ELS Viewer Workspace 

ELS Viewer offers a comprehensive environment to view the structural model and 

Applied Element Method (AEM) analysis results. The tools available are optimized 

to provide an illustrative and informative window on your results. The workspace 

consists of five main sections, as shown in Figure 2-1. They are listed below and are 

explained in this and the following chapter: 

 Menus: enable you to access all the different options and commands of the ELS 

Viewer.   

 Toolbars: provide quick access buttons to most of the program commands. 

 Browser Panel: enables you to access browsers which are used to display different 

features of the simulation results. 

 Control Bar: controls the display of frames and simulation animations, and shows 

important information about the current view. 

 Viewer Window: displays the structural model, Eigen modes, charts, contours, and 

Straining actions diagrams. 

 
Figure 2-1 The ELS Viewer Workspace 
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2.1 Menus 

This section provides brief descriptions of the menu commands available in the ELS 

Viewer. Commands are listed in tables according to the menus in which they are 

located, with a brief description of their function and their corresponding toolbar 

icons. If a specific command is described in detail else where in this manual, the 

location of this description is also mentioned.  

2.1.1 File Menu 

The File menu is used to perform the basic file operations of the program. Through 

this menu, you can open or close simulation files, export DXF, bitmap and AVI files. 

Table 2-1 contains descriptions of the commands in this menu.  

Table 2-1 File Menu Commands 

Command Icon(s) Function Details in… 

Open  Opens a simulation results file.  

Close  Closes the currently open simulation results file.  

Import Drafting 

Objects 

 Imports drafting objects created in the modeler into the 

viewer 

             Sec. 4.5 

Save Output  Enables you to save selected parts of the simulation.             Sec 4.4 

Export > DXF  Enables you to export a DXF file. Sec 12.3 

Export > Image  Enables you to export bitmap files. Sec 12.1 

Export > AVI  Enables you to export AVI videos. Sec 12.2 

Export >Elements  

Geometry 

 Enables you to export elements geometry Sec 12.4   

Export > STL and 

Obj 

 Enables you to export file as STL and Obj format. Sec 12.5 

Export >Script  Enables you to export Script from opened charts 12.6 below12.6 12.6 

Export >Setting  Enables you to export the ELV settings which you can 

recall them again at any ELV file 

 

Import >Drafts  Enables you to import drafts to  ELV  

Import >Setting  Enables you to import ELV setting  

Print Setup  Enables you to define printing settings.  

Print Preview  Shows a print preview for the active window.  

Print  Enables you to print contents of the active window.  

Exit  Close ELS Viewer.  

 
2.1.2 View Menu 

The View menu is used to customize the workspace and control the structure view 

to meet your preferences. Table 2-2 includes a brief description of the various options 

you can access from this menu. 
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Table 2-2 View Menu Commands 

Command Icon(s) Function Details 

in… 

Global Axes  Shows/Hides the global axes.  

Pan  Enables you to change the viewed part of the model. Sec 4.1 

Zoom > In  Increases the apparent size of the model by one step. Sec 4.1 

Zoom > Out  Decreases the apparent size of the model by one step. Sec 4.1 

Zoom > Dynamic  Allows you to zoom in or out dynamically by clicking the 

mouse and dragging it forward (zoom in) or backward 

(zoom out). 

Sec 4.1 

Zoom > Extents  Fits all model objects in the viewing window with the largest 

possible magnification by zooming in or out automatically. 

Sec 4.1 

Zoom > Selected 
 

Increases the apparent size of a selected area on a rectangular 

window. 

Sec 4.1 

Zoom > Window  Allows you to zoom on a specific area which you mark using 

your mouse. 

Sec 4.1 

Zoom > Previous  Displays the previous zoom view. Sec 4.1 

Refresh 
 

Redraws the model to update it with any changes that may 

have lagged due to insufficient memory. 

 

3D View > Isometric  Shows the isometric view of the model. Sec 4.2 

3D View > 

 (direction)  

 

Views the different sides of the model: front, back, left, right, 

top, and bottom. 

Sec 4.2 

3D View > 

 (rotate about an 

axis) 

 
Enables you to rotate the model about one axis (X, Y, or Z) 

using your mouse. 

Sec 4.2 

3D View > 

     Rotate about XYZ     
 Enables you to rotate the model in space in all directions 

using your mouse. 

Sec 4.2 

3D View > 

     (rotate about a 

screen  axis) 
 

Enables you to rotate the model about one axis of the screen 

(X, Y, or Z) using your mouse. 

 

3D View > 

Arc Bal l Rotate 
 

Enables you to rotate the model in all directions relative to 

the plane of the screen using your mouse. 

 

Clipping > Clip 

From > (direction) 

 Clips your structure from one of the different directions 

related to global axes. 

Sec 5.1 

Clipping > Clip 

From >  Volume 

 Applies volume clipping to your model. Sec 5.1 

Clipping > Flip 

     Clipping 

Direction 

 Reverses the current clipping direction. Sec 5.1 

Clipping > 

     Remove Clipping 

 Removes the applied clipping. Sec 5.1 

Clipping > 

   Clip View Setting 

 Set the clipping view settings  

Walkthrough  Activates the walkthrough mode, which allows you to 

navigate the 3D structure by walking around and through it. 

Sec 5.2 
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2.1.3 Problem Features menu 

The Problem Features menu enables you to view different features that can help you 

check the input data and have a better understanding of the results. The commands 

included in this menu are described in Table 2-3. 

Table 2-3 Problem Features Menu Commands 

  Command        Icon(s) Function Details in… 

Show Frame> 

 
 

Shows/Hides frame of the structure. 

 

Sec 6.1 

    

Elements  >Visible 

Elements 
 Show/Hide All elements or Outer elements or Outer 

Surfaces 

 

Elements > 

     Show Elements 
 Shows/Hides all elements or surfaces of the 

structure. 

Sec 6.1 

Elements > 

     Wireframe Mode 
 Shows elements as wireframes only instead of 

displaying them as solid shapes. 

Sec 6.1 

Elements >      

Shrink Elements 
 Shrinks element dimensions to 90% of their original 

size. 

Sec 6.1 

Elements > 

     Show Elements 

Numbers 

 Displays the numbers of each element at its centroid. Sec 6.1 

Elements >      Show 

Elements Centroids 
 Draws a dot at the center of each element. Sec 6.1 

Show Boundaries  

 

 

Enables you to select the problem boundaries to 

show: all, top, bottom, left, right, front, back, 

irregular boundaries and wireframe mode. 

 

 

 

Browser 
 

Shows/Hides the browser pane.  

Save Layout  Saves the problem window contents, toolbar locations, and 

browser selections.   

 

Load Layout  Loads saved windows for the same problem with their 

specific content, like charts or contours. Also loads toolbar 

locations and browser selections.   

 

Customize Toolbars  Enables you to select the toolbars to be displayed.  

Save Toolbars 

Layout  

 Saves the current toolbars layout.  

Load Toolbars 

Layout 

 Loads a saved toolbars layout.  

Reset Toolbars 

Layout 

 Resets toolbars layout to its default.  
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Show Springs   Shows/Hides springs setting.  

Show Link 

Members 
 

Shows/Hides Link Members.  

Show State 
 

This submenu enables you to choose which spring 

status to show. The available types of spring status 

are (Separated, Elastic, Yielded, In Tension, In 

Compression, Tensile Failure, Compressive Failure 

and Open Crack) 

 

Show Straining 

Actions 
 

Shows the Straining actions in the structural object.   

Show Sections  Shows the section locations where Straining actions 

are calculated. 

Chapter 10 

Show Contacts 
 

Indicates the occurrence of contacts between 

different elements. 

Sec 7.2 

Show Velocity 

Vectors 
 Draws velocity vectors, which indicate the direction 

and magnitude of element velocity. 

Sec 7.1 

Show Blast -Related 

Data 
 Show the blast position. Sec 7.4 

Show Blast Surfaces  Indicates the surfaces directly impacted by blast 

waves. 

Sec 7.4  

Auto Update 

Properties 

 Switches to updating field values automatically in 

the Properties browser. 

 

Update Data 

 

Updates the viewer with the latest results output 

from the solver, and enables the options to view such 

data. For example, if cracks or contacts do occur, the 

problem has to be updated in order for their show 

commands to be enabled. Only useful when solver is 

still running. 

 

Update Data 

Settings 

 Configures the viewer to update the charts and 

contours with the latest results from the solver. 

Opens the Update Data Settings dialog box. 

 

 
2.1.3 Select menu 

The Select menu enables you to select different objects in your structure. Table 2-4 

lists the commands in this menu with their descriptions.  

 

 

 

Table 2-4 Select Menu Commands 
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2.1.4 Charts menu 

The Charts menu enables you to perform chart-related operations. Table 2-5 contains 

descriptions of the menu commands. For more information on the creation of charts 

see Chapter 8. 

Table 2-5 Charts Menu Commands 

Command Icon(s) Function 

New Chart 

Window  
Enables you to create a new chart. 

Show Legend  Shows/Hides the chart legend. 

Animate  Allows you to view the chart being drawn as time or load steps increase.  

Switch X-Y Axes  Swaps the data plotted on the X and Y axes. 

Frequency 

Domain 
 

Draws a frequency domain chart instead of time domain.  

Edit Chart Data  Enables you to edit the data of the chart.  

Export Chart 

Data  
Exports chart data to a text file that can be input to other programs. 

Chart Options  Enables you to edit chart options. 

 

 

2.1.5 Contours menu 

Command Icon(s) Function Details in… 

Elements  Allows you to select elements.  

Springs 
 

Allows you to select springs.   

Sections 
 

Allows you to select a section of a component at which 

straining actions are calculated. 

 

Markers  Allows you to select a marker or a group of markers. Sec 13.0 

Show Selected 

Objects Only 
 

Shows the selected objects only, and hides all other objects.  

    

Hide Selected  

Objects Only 
 

Hides selected objects only, and shows all other objects.  

Show All Objects  Shows all objects.  

Hide All Objects  Hides all objects.  

Selection Range 

 
 

Enables you to select elements or springs using their ID 

numbers. 

 

Select by Name  Enables you to select object(s) by its(their) name(s).  

Select Elements By 

Coordinates 
 

Allow you to select Elements or Springs at certain points.  
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The Contours menu is used to adjust settings for drawing contours. In ELS Viewer, 

you can draw stress, strain, kinematics, blast pressure contours or OpenFOAM 

pressure. Table 2-6 lists the menu commands and their descriptions. For more 

information on drawing contour diagrams see Chapter 9. 

Table 2-6 Contours Menu Commands 

Command Icon(s) Function 

Elements 

Stress/Strain 
 

Enables you to draw a contours diagram based on stress/strain values.  

Element Kinematics  Enables you to draw a contours diagram based on kinematic property values. 

Blast Pressure  Enables you to draw a contours diagram based on blast pressure values. 

   

OpenFoam Pressure 
 

Enables you to draw a contours diagram based on OpenFoam pressure 

values. 

Show/Hide 

Contours  
Shows/Hides the active contours diagram. 

Show/Hide 

Contours Legend  
Shows/Hides the contours legend. 

Show/Hide 

Contours Values  
Shows/Hides the contours values. 

 
2.1.6 training Actions menu 

The Straining Actions menu is used to manage custom components that are used to 

calculate straining actions for components that ELS Solver does not automatically 

calculate. It enables you to add custom components, save them for later use and load 

them into the project and calculate and show/hide the envelope(s). Table 2-9 lists the 

commands in the menu together with brief descriptions for more details see 

section 10.2.2. 

Table 2-7 Straining Actions Menu Commands 

Command Icon(s) Function Details in… 

Add Custom 

Component 
 

Create new custom components. 10.1 

View Custom 

Component 
 

Show the custom component properties. Sec 10.4 

Custom 

Components 

Envelop Editor 

 

Calculate Envelop for the custom components and show/hide 

the Envelop. 

 

Save Custom 

Components 
 

Save the custom components that you created to *.cut file.  10.1 

Load Custom 

Components 
 

Load the previously saved custom components into the file. 10.1 

 

http://www.appliedscienceint.com/
http://www.extremeloading.com/


Extreme Loading® For Structures V9           Viewer Manual 

 

www.appliedscienceint.comꓲwww.extremeloading.com 21 

2.1.7 Tools menu 

The Tools menu is used to adjust the settings of many aspects of the program, and 

to view special types of information. Table 2-8 shows descriptions of the menu 

commands.  

Table 2-8 Tools Menu Commands 

Command Icon(s) Function Details in… 

New Eigen 

Window 

 Allows you to view the calculated mode shapes and the 

corresponding eigenvalues (frequencies or periods) for a 

structure. 

2.4 

New Separation 

Groups Views 

 Allows you to view the separation groups at separate 

window 

 

Units  Enables you to specify the unit set that will be used in the 

program. 

 

Statistics  Displays statistics and information about simulation results.  

Color Settings  Enables you to specify the colors and opacity for various 

elements of the structural model. 

Sec 5.4 

Light Settings  Enables you to adjust the lighting setting of the model’s 

environment to your preference. 

Sec 5.3 

Clip View 

Settings 
 Enables you to adjust the clipping settings. Sec 5.1 

Walkthrough 

Settings 

 Enables you to adjust the settings of the walkthrough mode. Sec 5.2 

Select Frame  Enables you to choose a specific frame to view.  

Drawing Size 

Settings 

 Enables you to change the drawing size of visual indicators. 5.5 

Preferences  Enables you to set the application preferences.  

Markers > 

(select marker 

shape) 
 

 

 

Enables you to insert different types of marker shapes into 

the model view for use in exported videos and bitmaps. 

Sec 13.0 

Separation 

Groups 

 Enables you to view and edit the display options of element 

separation groups. 

 

Selected 

Elements 

Details 

 Enables you to view information about the selected elements  

 

 

   

Selected Springs 

Details 

 Enables you to view information about the selected elements  

Selected 

contacts Details 

 Enables you to view information about the selected Contacts. 7.2 

Motion Path  Enables you to record AVI videos (avi files) to in which you 

can specify the motion path of the camera relative to the 

structure. 

4.5 
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Player Settings  Enables you to customize player settings by controlling 

which output frames are displayed. 

12.2 

Filtration  Enables you to select objects or mesh elements according to 

certain criteria. 

5.6 

Run Script  Enables you to run the exported script(s) of the drawn 

chart(s) . 

 

Shift 

Kinematics 

   

Ground 

Textures 

 Enables you to assign a specific texture for the ground based 

on a bitmap file. 

 

Camera Manger  Enables you to see the structure part from different angles  

Report  Enables you to create Report for the Viewer results like 

Straining actions or Stresses/Strains and Separations data 

 

2.1.8 Window menu 

The Window menu is used to manage windows in the program. It enables you to 

view multiple windows simultaneously, displaying different analysis information. 

Table 2-9 lists the commands in the menu together with brief descriptions. 

Table 2-9 Window Menu Commands 

Command Icon(s) Function 

New Window  Opens a new window. You can use multiple windows to display different 

information about the structure simultaneously.  

Duplicate 

Active View 

 Makes another copy of the open (active) window. 

Cascade  Organizes the open windows in a cascade view in front of each other. 

Tile 

Horizontally 

 Organizes the open windows by displaying them as horizontal tiles. 

Tile Vertically  Organizes the open windows by displaying them as vertical tiles. 

Arrange Icons  Arranges the icons of minimized windows. 

Full Screen  Activates the full screen mode. The main title bar, main menus, toolbars, and 

Windows task bar are all hidden. 

Open windows 

list 

 Displays a list of the currently open windows.  

2.2 Toolbars 
There are several toolbars in the ELS Viewer workspace that contain shortcut icons 

to most of the menu commands explained in the previous section. Table 2-10 lists 

them together with short descriptions of their use and notes on how to access their 

commands from the menus.  

Table 2-10 Toolbars in the ELS Viewer Workspace 

Name Toolbar Description/Notes 
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3D View 
 

Enables you to control the 3D view of 

the model. Commands are also 

accessible from the View menu. 

AVI Video 
 

Enables you to control the export of 

AVI videos. By default it includes a 

Start Recording button which switches 

to a Stop button when recording starts.  

Boundaries  

Toggles boundary view on/off. 

Commands are also accessible from 

the Problem Features menu. 

Charts 
 

Enables the creation and export of 

charts. Commands also accessible 

from the Charts menu. 

Clipping 
 

Enables you to view cross-section of 

your models in all directions. 

Contours 
 

Enables you to create contour 

diagrams. Commands are also 

accessible from the Contours  menu. 

Current 

Stage  

Displays the stage to which the 

currently displayed frame belongs. 

Export 
 

Enables you to export bitmaps and 

DXF files. Commands are also 

accessible from the File  menu. 

Markers 
 

Enables you to insert markers into 

exported bitmaps or videos. 

Commands are also accessible from 

the File  menu. 

Problem 

Features  

Enables you to view different features 

of the problem and check input data. 

Commands are also accessible from 

the Problem Features  menu. 

Select  

 

Enables you to select elements, 

springs, markers or contacts. 

Commands are also accessible from 

the Select  menu. 

Standard 
 

Enables you to perform basic 

operations like printing files, and full 

screen mode. Commands are also 

accessible from the File, Window, and 

Help menus. 

Units 
 

Enables you to set the program units 

and includes a field that displays the 

currently selected units. 

Velocity 

Vector 

Scale 
 

Enables you to change the drawing 

scale of the velocity vectors. Default 

value is 1.  
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View 
 

Enables you to zoom or pan the model 

view. Commands are also accessible 

from the View  menu. 

View 

Settings  

Enables you to control view settings of 

the model. Commands are also 

accessible from the Tools  menu. 

You can select which toolbars to be visible in the workspace in one of two ways: by 

clicking View >Customize Toolbars or right-clicking any of the displayed toolbars. 

This enables you to choose which toolbars to show/hide. 

2.3 Control Bar 

This bar at the bottom of the screen is functionally divided into two parts. One part 

enables you to control the animation of the simulation results. The second part 

consists of text boxes which display information about the mouse pointer 

coordinates, simulation times (or loading increments), the currently displayed frame 

number, show the selected elements and springs, player settings and refreshment. 

See Section 7.5 for more details about the control bar. 

2.4 Viewer Window 

The Viewer Window is the part where the structural model is actually displayed. 

Chapters 4 through 7 explain the different options you can use to control the model 

view within this window. Most of these functions are also accessible from the right-

click menu within this window.  

The Viewer Window can also display things other than the structural model itself. It 

can display charts, contours, Straining actions diagrams, or Eigen modes and their 

frequencies. Chapters 8 through 10 explain how each type of view can be obtained.  

You can view multiple windows at the same time. To open a new Viewer Window 

for the structural model, click Window >New Window. When the user requests them, 

contours and straining actions diagrams are displayed in the active window, but 

charts and Eigen views open in separate windows.  

When having multiple windows open, you can view them simultaneously by 

selecting one of the following options in the Window menu: 

 Cascade 

 Tile Horizontally 

 Tile Vertically 

Figure 2-2 shows an example of having four windows displayed at once. These are 

the different possible views of simulation results, clockwise from the upper left 
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corner they are: chart view, straining actions diagram, Eigen Window, structure 

view, and contours diagram.  

If chart animation is enabled, playing the simulation affects all views except the 

Eigen Window, which has its separate animation control.    

 

 
Figure 2-2 Simultaneous Viewing of Multiple Windows  
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3 Browsers 

Browsers are an important part of the ELS Viewer workspace. There are six browsers 

which can be viewed only one at a time in the browser pane. Each of them is used to 

manage the view of different types of information. You can select which browser to 

display by clicking its corresponding name from the browser selection area at the 

bottom of the browser pane shown in Figure 3-1. You can hide or show the pane by 

clicking the Browser ( ) button from the toolbars or View menu. This chapter 

explains the different functions of each browser.  

 
Figure 3-1 Browser Elements 

 

3.1 Structure Browser 

This browser is used to manage the display of structural components in your model. 

It enables you to view the components in a specific level in more detail than the rest 

of your structure for better understanding and viewing of your results. You can 
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perform operations directly by using the browser tree or the Structure dialog box 

which can be accessed by double-clicking any tree item.  

 

3.1.1 Structure Browser Tree 

The browser tree shown in Figure 3-2 enables you to perform the following 

operations:  

 Show/Hide various levels of the model. 

 Show/Hide the various structural components for each level or for the whole 

model.  

Each item in the Structure browser has a corresponding checkbox. By default, all 

checkboxes are selected ( ) indicating that they are visible in the Viewer Window. 

To hide an item in the Viewer Window, clear its checkbox.  

Figure 3-2 shows an 8-story building in two cases. The first one has all its structural 

levels visible. The second one shows the same structure but with only 5 levels 

displayed, and with the slabs of the fifth level hidden.  

It is not possible to hide or show a single structural component, like one slab or 

column, by using the structure tree. Such an operation can only be accomplished 

by using the Structure dialog box, which is discussed below. 
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Figure 3-2 Using the Structure Browser Tree to Show/Hide Elements 

In addition to the above options, the right-click menu of the structure browser 

offers many options to control the display of structural components for each 

level separately, or for the whole structure, as shown in Figure 3-2. From this 

menu, you can control the visibility of elements and springs based on their type 

or material, and show different straining actions diagrams. You can refer to 

Chapter 10. for detailed information about straining actions diagrams. 
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Figure 3-3 Structure Browser Context Menu 

 

3.1.2 Structure Dialog Box 

Double-clicking any of the tree items opens the Structure dialog box shown in 

Figure 3-4. This dialog box can be used to accomplish the operations performed from 

the browser tree, in addition to the following features: 

3.1.2.1 General Options :  

This section allows you to show or hide the frame of the selected item, and set the 

frame color. 

 

Figure 3-4 Structure Dialog Box – Activate/Deactivate Options 
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3.1.2.2 Elements Options :  

In this section, you can apply the visibility and display mode options that are 

accessible from the Problem Features menu and toolbar, to a specific level or 

component type. For detailed information about these options, see Section 6.1. 

You can also select to show/hide elements according to their type or material, and 

change the color of each type for the selected level, you can choose between the 

Visibility and Display mode options as shown in Figure 3-5. For more information 

about the global color options in ELS Viewer, refer to Section 5.4. 

 
Figure 3-5 Structure Dialog Box – Elements Options 

 

3.1.2.3 Springs Options :  

In this section, you can manage the display properties of springs in the selected level. 

This enables you to view the springs in a specific level in more detail than the rest of 

your structure.  

You can also select to show/hide selected spring collections or all springs according 

to their type or material, and change the color of each type or material for the selected 

level, as shown in Figure 3-6. You can also change the scale of the visual indicators 

(width and length) of the selected springs.  

Additionally, you can use the springs data grid to show or hide springs states for 

each spring type/material for the selected level.  
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Figure 3-6 Structure Dialog Box – Springs Options 

3.1.2.4 Straining Actions Options :  

In this section, you can adjust the settings of the Straining Actions diagrams for the 

selected level. The options available are:  

 Show/hide sections.  

 Set envelope limits.  

 Customize the appearance of the diagrams.  

 Customize the envelope properties.  

 View component properties.  

For detailed information about Straining Actions, please refer to Chapter 10. 
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Figure 3-7 Structure Dialog Box – Straining Actions Options 

 

3.1.2.5 Contours Options:  

This dialog is used to manage the display properties of contours in the selected layer, 

as shown in Figure 3-8. This enables you to view the contour diagrams for the whole 

structure or for a specific level or sub-level only, for better understanding and viewing 

of your results. You can refer to Chapter 9 for detailed information about the available 

types of contours, and the options for each type.  
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Figure 3-8 Structure Dialog Box – Contours Options 

3.1.2.6 Contacts Options:  

This dialog is used to manage the display types of contacts in the selected layer, 

as shown in Figure 3-9. This enables you to view the contacts types for the whole 

structure or for a specific level or sub-level only, for better understanding and 

viewing of your results. You can refer to Chapter7.2 for detailed information 

about the available types of contacts. 
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Figure 3-9 Structure Dialog Box – Contacts Options 

 

3.2 Input Data Browser 

This browser enables you to check various input data: loading scenarios, boundary 

conditions, elastic boundary, demolish/construct scenarios, lumped masses, lumped 

damping and rigid bodies. You can also use it to show or hide indicators for each of 

these inputs. This section discusses the browser tree, dialog box, and the different 

input indicator types.  

3.2.1 Input Data Browser Tree 

Items in the browser are arranged in a tree structure, consisting of four main 

categories: Stages, Demolish/Construct, Lumped Mass, lumped damping and Rigid Body. 

The Stages category has the input loading stages, numbered from 1 upwards. Each 

stage can have one loading type, plus any boundary conditions, elastic boundary, 

initial velocity or initial acceleration. Figure 3-10 shows an instance of the browser. 

Selecting the corresponding check box for a tree item displays its indicators.  
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Stage indicators are not displayed except within the time frame of their stages. 

Initial velocity and initial acceleration are only defined on dynamic loading 

stages. 

 

 

 
Figure 3-10 Input Data Browser 

 

3.2.2 Input Data Dialog Box 

Double-clicking any of the entries in the browser opens the Input Data dialog box. 

This dialog box displays the input data values for any entry together with options 

for managing the display of indicators. Figure 3-11 shows this dialog box in the case 

of a static concentrated load. In this dialog box, the input load values are displayed 

in the table at the bottom. The Show Loads and Show Moments check boxes enable you 

to display indicators only in the selected directions.  
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Figure 3-11 Input Data Dialog Box 

 

In Figure 3-11, there are loads applied to some elements. With the Show Loads and 

Show Moments selections shown, only the loads in the Y-direction are displayed in 

the Viewer Window, as shown in Figure 3-12. The Arrow Properties and Text 

Properties sections enable you to manage the indicators of this load type. 

 
Figure 3-12 Arrows Indicating Static Load Applied to Two Columns 
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3.2.3 Input Data Indicators 

Different load types have different indicators, hence different options for managing 

their display. Table 3-1 shows the indicator type for each input data type. These 

indicator types are discussed below.  

 

Table 3-1 Types of Input Indicators 

Input Data Type Indicator 

L
o

ad
in

g
 S

ce
n

ar
io

s 

S
ta

ti
c 

Concentrated Loads Arrows 

Displacements Arrows 

Hydrostatic Pressure Highlighted Elements 

Uniform Pressure Highlighted Elements 

Moving Load Moving Arrow 

Line Load Load Distribution 

Custom Load Load Distribution 

 Static OpenFOAM None 

D
y

n
am

ic
 

Concentrated Loads Arrows 

Displacements Arrows 

Earthquake None 

Blast Blast Surfaces 

Custom Blast Blast Surface 

Uniform Pressure Highlighted Elements 

Moving Load Moving Arrow 

Custom Load Load Distribution 

Pressure Sources Highlighted Elements 

Vehicle Load Load Distribution 

  Synchronous OpenFOAM None 

  OpenFOAM None 

Boundary Conditions Arrows 

Elastic Boundary  Arrows 

Lumped Damping Arrows 

Edit Element Material Highlighted Elements 

Lumped Mass Highlighted Elements 
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Demolish/Construct Scenario  Highlighted Elements 

Spring Controller Settings Highlighted Region 

Element Spring Highlighted Elements 

Initial Acceleration Arrows 

Initial Velocity  Arrows 

Rigid Body Highlighted Elements 

Arrows are used to indicate concentrated and displacement loads, lumped masses, 

boundary conditions, elastic conditions, initial velocity and acceleration. Loads in a 

direction are marked with an arrow pointing in that direction with the load valued 

typed beside it. 

Moments or boundary rotational restraints are indicated by double-headed arrows 

pointing in the direction around which they are applied. Figure 3-13 shows an 

example of arrow indicators for a static load in the X-direction and a moment around 

the Y-direction. The size of the arrow and its color can be changed from the 

corresponding Input Data dialog box.    

 

Figure 3-13 Arrow Indicators 

Pressure loads and non-directional input data like demolish or construct scenarios 

are indicated through the highlighting of elements. By default, the elements are 

highlighted in yellow, as shown in Figure 3-14; but this color can be changed from 

the Input Data dialog box.  
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Figure 3-14 Highlighted Elements 

Static and dynamic moving loads are indicated by a line, showing the path along 

which the load moves, and an arrow, indicating the load direction. When playing 

back the simulation, this line moves from the path start to its end, indicating its 

location at every time instance it is applied. Figure 3-15 shows an example of a 

moving load indicator.  

 
Figure 3-15 Moving Load Indicator 

For blasts, there are three indicators: bomb location, blast surfaces, and blast 

waveforms. For more information on blast indicators, see Section 7.4 Blast Surfaces 

Static line loads are indicated by a line with the load distribution as shown in 

Figure 3-16 with load intensity values shown at both ends of the line.  

 

Figure 3-16 Line Load Indicator 
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3.3 Markers Browser 

This browser is used to manage markers. Markers can be used to illustrate specific 

information or mark parts of the structure in the exported bitmaps or videos you 

create for an analysis. Section 13 describes in detail the use of markers.  

 
Figure 3-17 Markers Browser 

In this browser, you can create layers which can be used to group different markers 

together, as shown in Figure 3-17. You can also hide or show entire layers and the 

markers within them by selecting the check boxes beside their names. To assign a 

marker to a certain layer, you need to make it the default layer first by using its right-

click menu then inserting the marker. Double-clicking any of these layers opens the 

Markers dialog box, shown in Figure 3-18, from which you can edit the properties of 

markers, such as position, scale and rotation. You can also delete markers from 

within this dialog box. 
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Figure 3-18 Markers Dialog 

3.4 Conditional Solver Controller Browser 
This browser is used to manage actions that will be executed by the solver at a specific 

time in the analysis or when specific condition met the requirements as shown in time 

(or when the condition met the requirements). 

 Activate Elements: Activate certain element(s) at a certain time (or when the 

condition met the requirements). 

 Activate Contacts: Activate certain contact type(s) at a certain time (or when 

the condition met the requirements). 

 Activate Springs: Activate certain spring(s) at a certain time (or when the 

condition met the requirements).  

 Springs Area Ratio: Change the area for certain spring(s) during certain time 

range (or when the condition met the requirements). 

 Spring Temperature: enable the user to assign temperature for certain 

spring(s) during certain time range (or when the condition met the 

requirements). 

 Spring Prestress:  Assign prestress force for certain spring(s) during certain 

time range (or when the condition met the requirements). 

 

.  

Using the Conditional Solver Controller browser, you can add various action types, 

including: 
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 Pause: Pause the calculations of the solver at a user specified time (or when 

the condition met the requirements) in order to carry out one of the following 

actions. 

 Remove Elements: Remove selected elements at a set time (or when the 

condition met the requirements). 

 Remove Springs: Remove selected springs at a set time (or when the 

condition met the requirements). 

 Add Boundary Condition: Add a new boundary condition at a set time (or 

when the condition met the requirements), by specifying displacement and/or 

rotation restraints. 

 Remove Boundary Condition: Remove an existing boundary condition at a 

specific time (or when the condition met the requirements). 

 Assign Velocity: Assign velocity and angular velocity at a specific time (or 

when the condition met the requirements). 

 Assign Acceleration: Assign acceleration and angular acceleration to at a 

specific time (or when the condition met the requirements). 

 Add Backup: Create Solver Backup at certain loading stage and step number 

(or when the condition met the requirements). 

 Switch Solver: Switch the Solver type (Exact or Iterative) at certain time (or 

when the condition met the requirements). 

 Periodical Backup: Create Solver Backup at every periodical time while 

solver running (or when the condition met the requirements).  

 Activate Eigen: Create Eigen modes at a certain time (or when the condition 

met the requirements). 

 Activate Elements: Activate certain element(s) at a certain time (or when the 

condition met the requirements). 

 Activate Contacts: Activate certain contact type(s) at a certain time (or when 

the condition met the requirements). 

 Activate Springs: Activate certain spring(s) at a certain time (or when the 

condition met the requirements).  

 Springs Area Ratio: Change the area for certain spring(s) during certain time 

range (or when the condition met the requirements). 

 Spring Temperature: enable the user to assign temperature for certain 

spring(s) during certain time range (or when the condition met the 

requirements). 

 Spring Prestress:  Assign prestress force for certain spring(s) during certain 

time range (or when the condition met the requirements). 
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Double-clicking Solver controller, the Solver Controller dialog box open, shown in 

Figure 3-20 where you can view and add actions. 

Figure 3-19 Solver Controller Browser 
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Figure 3-20 Solver Controller Dialog 

 

 

User can add action by check the Add Condition option then Edit condition 

where the Filtration dialog open to add any condition. At this time the 

Conditional Solver Controller will apply when the condition met the 

requirement, as shown Figure 3-21. 
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Figure 3-21 Conditional Solver Controller- Add condition option 

 

For the conditional Solver controller actions (using Add condition option) you 

can use the Inspect Log File option, shown in Figure 3-22 . Log File dialog will 

display the Frame Number, Time, Condition, Actions and Have Results 

(Number of elements or springs which met the Filtration condition). User can 

check the Select option to select the Have Results at the viewer display window.  
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Figure 3-22 Conditional Solver Controller-Log File 

 

Animate option will give you the ability of select and show only the applied 

condition(s) to display it (them) on the viewer window at its occurred time while 

running the viewer clip, shown in Figure 3-23. Add to Selection execute the 

animate action(s) to the previous selection.  
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Figure 3-23 Conditional Solver Controller- Animate Log 

3.5 Material Types Browser 

This browser is used to view different material types (Concrete, steel, elastic, brick, 

etc.) Figure 3-24 shows Material types. Open the browser, select a material and 

double click it, then its properties dialog box will open.     
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Figure 3-24 Material Types Browser 

3.6 Windows Browser 

This browser is used to view list of all opened windows of the file such as display 

graphic windows, contours, chart and Eigen as shown in Figure 3-21. It is used also 

to save those windows for being used later on. 

http://www.appliedscienceint.com/
http://www.extremeloading.com/


Extreme Loading® For Structures V9           Viewer Manual 

 

www.appliedscienceint.comꓲwww.extremeloading.com 49 

 

              Figure 3-25 Windows Browser 

3.7 Scenes Browser 

The user can save scenes and activate it when needed. This is carried out using the 

scene browser shown in Figure 3-26. The scene is initially created clicking the Add 

button shown in Figure 3-26. To activate the scene, it is selected and the Activate 

button is clicked. In order to remove the scene, simply click the Remove button after 

selecting the scene. From Export and Import user can export created scenes and 

import them again at the same opened ELV or in new ELV. 
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              Figure 3-26 Scenes Browser 

 

3.8 Filtration 

This browser can be used to allow the user to have different criteria and options 

to select from. Filtration tap show Elements, Springs, Straining Actions, 

Contacts, Elements Equations, Springs Equations, Straining Actions Equations 

and Contacts Equations filters as shown Figure 3-27. 
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Figure 3-27 Filtration Browser 

User can add any filter by double click on any filter or use the right click menu, 

shown as Figure 3-28.  

 

Figure 3-28 Add/Delete Filter 
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After adding new filter, user can open the filter details (for example elements 

filter details shown in Figure 3-29), generate the filter, select Range criteria and 

choose the Render Options.   

 

 

3.9 Properties Browser 

This browser can be used to view properties of a selected object, element, spring, 

link member, section, or marker. Open the browser then select an object.  

It is important to note that different object types have different properties. 

Figure 3-30 shows the Properties browser for a selected spring at the left and a 

selected element at the right. Note how the property categories are different, as stress 

and strain are calculated for springs but not elements. Likewise, velocity and 

acceleration are only calculated for elements. Even within a category having a 

similar naming like geometry, the properties themselves are different.   

Figure 3-29 Filter Details 
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Figure 3-30 Properties Browser 

The properties values displayed in the window are those for the currently displayed 

frame. By default, the values are not automatically updated if you animate the 

simulation, and to see the properties at a different frame, you have to select the 

element again in this frame.  

Another way to read property values at different frames is to click the Auto Update 

Properties option from the Problem Features menu. This updates all values 

automatically as frames change, but is turned off by default to save processing 

resources.  
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4 Basic Operations 

This chapter explains the following basic features and operations available in the 

ELS Viewer: 

 Model navigation operations like zooming, panning, and 3D viewing  

 Element selection methods and uses of selections 

 How to extract only part of the output and save it in a new folder  

4.1 Panning and Zooming 

Panning and zooming are two operations that can help you obtain the required view 

of your model. Zooming achieves this through changing the magnification of the 

view, while panning moves the view. Both options enable you to take a closer or 

better look at a specific part of your structural model.  

4.1.1 Panning 

Panning has the effect of moving the location of the viewer window from which you 

look at the model. Note that it does not change the location of the model but merely 

changes the view – the location from which you look. Looking at Figure 4-1, what 

you see on the program screen on the right can be changed by moving the “virtual” 

window illustrated on the left using the panning “hand”. 

       
Figure 4-1 Panning 

You can activate the panning mode by clicking the  button from the View toolbar 

or selecting Pan from the View menu. When in the panning mode, you will notice 

that the mouse cursor changes to a hand shape. 

After activating the panning mode, you can start to pan your view by moving your 

mouse in the model viewing window while pressing the left-click mouse button. 

When you are done, you can deactivate this mode by pressing the <Esc>key on your 

keyboard or right-clicking in the viewing window and selecting the Cancel 

Navigation command.  
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There is a quicker way to pan your view if your mouse has a clickable scroll wheel which 

can be used as a third mouse button. You can pan by pressing this button while moving 

your mouse without having to turn on the panning mode from the toolbar or menu. When 

you release the scroll button you do not have to exit the mode manually as it is done 

automatically. 
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4.1.2 Zooming 

Similar to panning, zooming is an option that can change your view of the model. It 

changes the drawing scale of the model on the screen, or in other words, it magnifies 

the view.  

There are several zoom options in the ELS Viewer, which you can access from the 

View toolbar or menu. Below, their functions are explained in detail. 

 Zoom In (  ): click this button to increase the magnification factor of the view. 

Objects appear two times (2x) as large with every click. 

 Zoom Out (  ): click this button to decrease the magnification factor of the view 

by a step of 2x resulting in objects appearing smaller.  

 Zoom Dynamic (  ): clicking this button enables you to change the magnification 

factor of the view in smaller steps than 2x so that you can obtain the exact 

magnification scale you need. Click your mouse in the viewer window and drag 

your mouse forward to zoom in or backward to zoom out.   

 Zoom Extents (  ): clicking this button automatically zooms in or out to fit all 

model objects in the screen with the largest possible magnification. 

 Zoom Selected ( ): Increases the apparent size of a selected area on a rectangular 

window. 

 Zoom Window (  ): this command enables you to zoom on a specific area of the 

view. To do so, click this icon then drag your mouse while pressing the left-button 

to draw a window enclosing the area you wish to magnify. 

 Zoom Previous (  ): clicking this button cancels the effect of the most recent view 

change whether zooming and panning thus returning to the previous view. You 

can click it several times to restore more previous view settings.  

 Render Lock (  ): click this button to lock the ELV window on its current view.  

Note that Zoom Dynamic and Zoom Window both activate modes which cause the 

mouse cursor to change its shape. To exit such a mode and return to the default 

mode, press the <Esc>key or choose Cancel Navigation from the right-click menu.  

If there is a scrolling wheel in your mouse, you can use it to zoom in or out directly without 

using any of the previous toolbar buttons. Scrolling up zooms in, while scrolling down 

zooms out. 

 

4.2 3D Viewing and Rotation 

The ELS Viewer displays models in a three dimensional (3D) view with seven preset 

3D viewing directions: isometric (  ), front (  ), back (  ), right ( ), left (  ), 

top (  ), and bottom (  ). These different viewing directions are defined relative 

to the global axes: front and back for the Y-axis, right and left for the X-axis, and top 

and bottom for the Z-axis. Figure 4-2 illustrates these different directions.  
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Figure 4-2 Viewing Directions 

You can select the required view by clicking the corresponding button either from 

the 3D View toolbar or from View >3D View. Note that when any of these views is 

selected, all panning and zooming performed is reset. 

Other than the preset 3D view directions, you can customize the viewing direction 

by dynamically rotating the model in space using commands that rotate it about the 

X-axis ( ), Y-axis (  ), and Z-axis (  ). Clicking on any of these buttons causes 

the mouse cursor to change its shape in the model viewer window to indicate 

activation of a rotation mode. To rotate the model, move your mouse around while 

pressing the left-button. Press the <Esc>key or Cancel Navigation from the right-click 

menu when you are done to exit the rotation mode. 

If you need a more flexible 3D view rotation tool, you can use the Rotate About XYZ 

(  ) option which enables you to rotate the model around the origin, not just one 

axis.  

Although the Rotate About XYZ tool is more flexible, it needs more experience to control. 

It is advisable to use it after trying out the single-axis rotations just to tweak the view to 

your exact viewing preference.    

 

In addition to rotating the model relative to the global axes, you can rotate the model 

relative to the plane of your screen, about the X-axis (  ), Y-axis (  ), and Z-axis 
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 ( ). For more flexible 3D rotation about the screen, you can use the Arc Ball Rotate 

option ( ). 

For more 3D viewing options, use the Walkthrough mode. (See Section 5.2) 

4.3 Making Selections 

This section discusses the different selection methods, the objects that can be 

selected, and the uses of selections. You may need to select objects in one of the 

following cases: 

 To view detailed properties of an element or spring in the Properties browser 

(only possible for a single selected object). In case of markers, you can view and 

also edit properties of multiple selections at once. See12.613 for more details on 

the Properties browser and Section13 for more information on markers. 

 To show or hide a group of selected elements, which is discussed in this section. 

 To view staining actions details at a selected component section. This is done by 

selecting a section then choosing Component Straining Actions Details from the 

right-click menu. For more information on this feature refer to Chapter 10. 

 To perform some commands in ELS like creating custom components or charts, 

you will be required to make selections. For example, to plot a chart, you will be 

requested to select the elements whose data will be plotted.  

You can select any of the following types in ELS: elements (  ), springs ( ), link 

members (  ), sections (  ), markers (  ), or contact ( ).To select an object you 

must first make sure that it is displayed, or else its selection button will be disabled. 

To display a type of objects use the Problem Features menu or toolbar (see Chapter 6 

for more details). Note that you can only select objects of one type at a time.  

The action of selection itself is simply done by clicking an element if a single selection 

is required. If you need to make multiple selections, click the mouse and drag it to 

draw a window over the desired elements, or keep the <Ctrl> (or <Shift>) key pressed 

while selecting elements to add them to the existing selection. Clicking a selected 

element deselects it.  

When selecting a spring use the window selection method, since springs are small and 

hence difficult to select by clicking them directly.  

When making a window selection, you should note that all elements within this 

window, including those hidden behind other elements will be selected. Figure 4-3 

shows an example of a slab selected from the top view. If it is selected by single 

selection, i.e. select elements one by one by clicking them, just the elements visible 

from the top are actually selected. If all the elements of the slab are selected using a 

window, all other slabs beneath it will also be selected. 
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Figure 4-3 Selection Methods 

The window method selects both fully or partially enclosed elements. 
 

There are ways to select such a slab using window selection, which will save time 

compared to selecting all its elements one by one. One way to do that is by hiding 

all other levels using the Structure browser before making the selection, so that there 

are no elements below the slab. Another way is to hide all columns and girders then 

select the slab from the front view.  

Besides making selections using the mouse, you can make precise selections of 

elements by specifying their ID numbers in the Selection Range dialog box shown in 

Figure 4-4 which you can access from the Select menu. This dialog box lets you select 

elements or springs within a specified range.  
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Figure 4-4 Selection Range Dialog Box 

When selecting elements or springs, you type in the first element/spring number in 

the From text box, the last one in the To text box, and the step between each two 

consecutive elements/springs in the range. For example, if the input numbers are as 

shown in Figure 4-4, then the selected elements will be 40, 42, 44, 46, 48, and 50.  

If you want to add this new selection to an already existing one, check the Add to 

Selection checkbox.  

Also you can select by type the object name from Select by Name as shown Figure 4-5. 

Press Add to enter the object(s) name(s). Object name should be exact as which 

appear at the ELS. 

 

Figure 4-5 Select by Name 
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In addition, you can use Select Elements by Coordinates. Press Add or Import/Export the 

points coordinates, as shown Figure 4-6.  

 

Figure 4-6 Select Elements by Coordinates 

 

There are options in the Select menu that can be used to show or hide the selected 

objects, or to show or hide all objects.  

To show or hide a specific structural component, component type, or even a whole 

level use the Structure browser. (See Section 3.1 for more details) 

4.4 Selective Saving of Output 

Selective saving of output is an option that enables you to save only a selection of 

the frames of the simulation output results.  This is useful in case you need to keep 

only important frames, want to change the order of frames in the simulation, or 

simply reduce the disk space occupied by the simulation output files resulting from 

too many frames. (You can know how much space is occupied by the simulation 

output using the Statistics dialog box accessible from the Tools menu.) 

To use this option select Save Output from the File menu to open the Save Output 

dialog box shown in Figure 4-7. You can choose the frames to save in one of two 

ways: 

 Specify the first and last frames in a sequence together with the step between each 

frame and the next one. For example, the numbers in Figure 4-7 would result in 

frames 1, 3, 5, 7 and 9 to be saved. 
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 Select the Custom Frames option and type frame numbers in the corresponding 

text box, separated by commas or dashes. This method is best if you would like to 

select frames without a specific arithmetic sequence. For example, writing 2, 5, 7-

10 will choose frame 2, frame 5, and frames 7 through 10. It is also possible to mix 

frames by writing something like: 1, 10, 5, 7… in the text box. 

 
Figure 4-7 Save Output Dialog Box 

Finally, you will need to specify a destination path to save the selected frames in. 

Click the Browse button to select a directory.  

You cannot save frames in a folder containing other ELS output and will be warned if 

such a folder is selected.  

4.5 Import Drafting Objects 

Importing drafting objects to the viewer is an option that enables you to import draft 

lines from the modeler. This is useful in case you need to import certain draft lines 

to use as a general reference or as a path for the camera movement in the Motion 

Path command. Importing a file allows you to import the existing plans in certain 

levels or certain layers to be created in your ELS model. 

How to open this dialog select File from the File menu then select the items or levels 

to import as shown in the following figure (Figure 4-8) and press OK. 
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Figure 4-8 Importing drafting objects. 

 

4.6 Export and Import ELV Settings 

Using the file menu, you can export the Viewer settings and import them at new viewer as 

shown in Figure 4-9 

 

      

 

Figure 4-9 Export and Import Settings 
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5 Display Modes and Settings 

This chapter explains advanced display features for model navigation and view 

settings customization. The topics covered by this chapter are: 

 Clipping and Walkthrough modes 

 Customizing lighting, colors, transparency, and drawing size settings 

5.1 Clipping 

Clipping is an option that helps you view elements of your model that are normally 

hidden behind others. It does so by clipping the elements obstructing their view. It 

can also be considered as a tool for viewing cross-sections of your model from 

different directions. Figure 5-1shows an example of clipping.  

 
Figure 5-1 Clipping from the Top Direction 

There are two types of clipping in the ELS Viewer, plane clipping and volume 

clipping. Plane clipping, on one hand, can be used to “cut” your model from 

different sides, but only one at a time. Volume clipping, on the other hand, clips your 

model from many sides at the same time.  

You can access clipping options from the View menu or the main viewer window 

right-click menu. To apply volume clipping, you must first specify the coordinates 

of two diagonally opposite vertices of a cube. All elements outside this cube are 

clipped. These two vertices are defined in the Clip View Settings dialog box which 

is shown in Figure 5-2 and is accessible from the Tools menu, the right-click menu, 

or the button in the View Settings toolbar. You can type in the coordinates of the 

vertices directly or choose to select them from the screen using your mouse by 

clicking the Pick button.  

To apply plane clipping, choose one of the clipping directions: front, back, right, left, 

top, or bottom. You can move the clipping plane by using the <+> and<->keyboard 

buttons. Pressing<+> moves the plane to clip more of your model, while pressing <-

>decreases the amount of clipping. The step by which the clipping plane moves with 
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every button press can also be changed from the Clip View Settings dialog box. It is 

specified in terms of the length unit in use. 

 
Figure 5-2 Clip View Settings Dialog Box 

You can also choose the Flip Clipping Direction option to reverse the direction of 

clipping. Finally, to remove the applied clipping, whether plane or volume, select 

the Remove Clipping command. 

5.2 Walkthrough 

The walkthrough mode enables you to navigate your 3D structure as if you are 

“walking” around it or even through it. To activate the walkthrough mode, click the 

 button on the View toolbar or select Tools>Walkthrough.  

In this mode, no panning or zooming is possible. Instead, you can change your 

standing position around the structure by using the <Shift>, <Page Up>, <Page 

Down>, and arrow keys. You can move around, change the direction in which you 

are looking, descend, or ascend by using the key combinations shown in Figure 5-3.  
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Figure 5-3 Navigation Keys in the Walkthrough Mode 

If you find that you are moving too slow or too fast with every key pressed, you can 

change the moving and rotating step sizes from the Walkthrough Settings dialog box 

shown in Figure 5-4, which you can access from the Tools menu. 

 

 
Figure 5-4 Walkthrough Settings Dialog Box 

Finally, to exit the walkthrough mode, click the  button once more. 

5.3 Light Settings 

When viewing a 3D model, light settings can have dramatic effects on the way it 

appears. When properly used, it can help you obtain the best and clearest view of 

your structural model.  

ELS gives you complete control on the light sources around your model using the 

Light Settings dialog box shown in Figure 5-5. You can open this dialog box by 
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clicking the  button on the View Settings toolbar or selecting Light Settings from 

the Tools menu.  

 

Figure 5-5 Light Settings Dialog Box 

The lighting color is further divided into three parts:  

 Ambience, which represents how the model reflects light which is falling at it from 

all directions uniformly, as if modeling light from the sky. 

 Specular, which represents how the model reflects light which is falling at it from 

a point source. Each surface will reflect this light uniformly in all directions with 

intensity depending on whether the surface faces towards the light source or away 

from it. This type of reflection is what best defines the 3D shape of a model. 

 Position, which represents the position of the light source. 

 

Figure 5-6 shows the effects of the ambience, diffusion and amplification. 

 
 

Figure 5-6 Ambience, Diffusion and Amplification effects 
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5.4 Color Settings 

In ELS you can change the color of objects that appear inside the viewer window. 

Color of structural components like girders and slabs can be set by clicking the small 

colored boxes beside their names in the Structure browser tree. To color just one slab 

or girder, not all of them, you can do so by using the Properties browser (see 

Section 03.1 for more details).  

To set colors of non-structural objects (like boundaries, springs, and viewer 

background) or indicators (like element centroid and velocity vectors), use the Color 

Settings dialog box by clicking the button or selecting Color Settings from the Tools 

menu. The dialog box is shown in Figure 5-7. Choose the required components from 

the table shown then select its color from the palette.  

 

Figure 5-7 Color Settings Dialog Box 
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To set colors of the various materials available in your project, you can use the 

Material Types dialog box by selecting Material Types Browser and double click 

on any material type from the tree. The dialog box is shown in Figure 5-8. The 

dialog box has a list of all the materials in the project, and the color of each. You 

can click on the color of any material to change it. The change applies to all 

objects that use this material. 

 

Figure 5-8 Material Colors Dialog box 

5.5 Drawing Size Settings 

In the ELS Viewer, you cannot change dimensions of structural components, as it is 

just a viewer program. Such changes affect the problem solution and hence are only 

made in ELS Modeler when defining the structure. However, you can change the 

dimensions of visual indicators for springs, contacts, cracks, etc. 

For example, if you feel that element centroids are too small or that matrix springs 

are too large, you can change their drawing sizes easily by using the Drawing Size 

Settings dialog box accessible from the Tools menu, as shown in Figure 5-9. You can 

change the drawing size of any object by typing a number (percentage of the default 

size) in its corresponding Value (%) cell.  

Indicators are drawn with sizes relative to the average problem element dimensions 

or to the element to which they belong. For example, contact sizes are relative to the 

overall average since they do not relate to just one element, while spring lengths are 

relative to their respective element dimensions.  
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The number in the Average Element Radius text box is the value to which all 

dimensions in the dialog are related. This value is not editable. 

 

Figure 5-9 Drawing Size Settings Dialog Box 

5.6 Filtration 

In the ELS Viewer, you can make filtration to facilitate selection process of 

certain springs, elements with certain material, certain layers, certain levels, 

elements with certain kinematics level such as elements with displacements less 

than or greater than certain value, … etc.  

For example, as shown in Fig. 5-10, a filtration criteria for filtrating elements 

with “Normal Steel” material, while Fig. 5-11 shows filtration criteria for 

filtrating elements with either “Normal Steel” material or “Normal Steel” springs. 

You can check the Show Results only option to show the filtration results only at 

the viewer window. 

 

 

 

 

 

 

http://www.appliedscienceint.com/
http://www.extremeloading.com/


Extreme Loading® For Structures V9           Viewer Manual 

 

www.appliedscienceint.comꓲwww.extremeloading.com 71 

 
Figure 5-10 Filtration for elements with “Normal Steel” material 

 

 
Figure 5-11 Filtration for elements with either “Normal concrete” material or “Normal Steel” springs 
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In Filtration you can save Queries by press New Query and to use them press 

Activate Query as shown in Fig 5-12. Also Queries can be exported as (*.qurv) 

file and imported in any suitable viewer results file.  

 
Figure 5-12 Adding New Query of Filtration. 

 

5.7 Camera Manger 

ELS Results Viewer enables the user to move through the structure to select a 

certain scene at a certain frame. It is a useful option that user can see the interior 

structural components .User has the ability to change the camera position and 

both horizontal and vertical angle shown Figure 5-13. 
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User can show the Contour for the structure and use the camera manger option 

for more clear view as shown Figure 5-14 . 

Check the activate option then you can change in the Horizontal and vertical 

camera angle and also change the camera position to move through the 

structure. 

Also you can hide the camera manger dialog and keep its action by click on Hide 

option. 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 5-13 Camera Manger 
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5.8 ELS Viewer Report 

In the ELS Viewer, you can create Report for the ELS Results. As shown in figure 

5-15.  Browse to select the path at which the report creates, then check the option 

you need from the statistic options. Add tables and figures using the Report 

modeling option. Also you can select from the Axillary Data options which you 

want to create at the Report. Press Generate to generate the ELS Report as shown 

in figure 5-16  

Figure 5-14 Use Camera Manger for view the Interior Structure Components 
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Figure 5-15 Report Generator dialog 

 
Figure 5-16  The generated ELS Report 
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6 Object Display Options 

This chapter explains the different viewing features of the objects constructing any 

model: 

 Elements. 

 Springs. 

 Boundaries.  

It also discusses the different 3D rendering modes of these objects and methods of 

selecting which of them to show and which to hide.    

6.1 Elements 

When defining a problem in ELS, you determine how to break structural 

components into smaller building blocks referred to as matrix springs or mesh 

elements. This section discusses the different display modes and options that can be 

performed on these elements.  

ELS enables you to view certain elements from the ( )button, just you press the 

button the Show/Hide Elements Settings dialog will appear. You can check which 

element(s) material(s), object(s) type and at which level(s) you want to show/hide at 

the viewer display window. Also ELS offers to view elements in different rendering 

modes: solid, shrunk, or wireframe. In wireframe mode, only the outer frames of 

elements are displayed without the surfaces being rendered. In solid mode however, 

all surfaces are rendered and colored. While solid mode enables you to better 

visualize the structure, wireframe mode enables you to see elements that are 

normally hidden behind other elements; it does this without hiding those 

obstructing the view. Wireframe mode also makes it easy to differentiate between 

individual elements and adjacent ones, something that is not possible in solid mode 
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as shown in Figure 6-2. Also user can set the Opacity option for clear the view from 

the Property of the selected object shown in Figure 6-3 the opacity range is from 1 to 

10. (10) mean that the object will appear as opaque and (1) mean it will be 

transparence.  

Shrunk elements mode also helps differentiate individual elements but without 

sacrificing their solid look. This is done by drawing elements at 90 % of their original 

size, hence emphasizing the interfaces between elements. It is also possible to 

activate both shrunk and wireframe modes simultaneously. Figure 6-1 shows all 

possibilities of element rendering in the ELS Viewer.  

You can select the element display mode from the Problem Features menu or from 

the toolbars. The button toggles between solid and wireframe modes while the 

button toggles between shrink and normal size modes or use Show elements 

dialog shown in Figure 6-1.  

 

 

 

 

 

Figure 6-1 Show Elements 
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Figure 6-2 Element Display Modes 

 

 

Every element is given a unique ID number in ELS which can be displayed by 

clicking the  button. To view just the element centroids click the  button on the 

Problem Features toolbar or check them from the Show Elements dialog Figure 6-1. 

Figure 6-4 shows how element numbers and centroids are displayed in ELS.  

Figure 6-3 Opacity Option 
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Figure 6-4 Display of Element Numbers and Centroids 

You can also toggle the display of all elements on or off, view outer elements, or 

outer surfaces from the Problem Features menu or by clicking the arrow beside the 

button in the Problem Features toolbar or Show Elements Dialog.  

While it is not possible to change the color of an individual element, you can set the 

color with all the display modes for an individual structural component or all 

components of a specific type by using the Structure browser.  

6.2 Springs and Link Members 
Springs are generated by the ELS solver for use in AEM (Applied Element Method) 

computations. There are three types of springs: matrix, steel, and RFT springs. They 

are not displayed by default as they normally exist in large numbers and viewing 

them requires large processing power. You can show or hide springs from the 

Problem Features menu or by clicking their display button  which open the 

Show/hide Springs Settings dialog as shown in Figure 6-5, then check from the 

Springs Materials Settings and levels which springs to show. Or from the right click 

menu of Structure Browser as shown in Figure 6-6, then selecting which type of 

springs to show. Link members on the other hand, are displayed by default and can 

be hidden by de-selecting the option from the right-click menu of the Structure 

browser. 
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Figure 6-5 Show/hide Springs settings 

  

 
Figure 6-6 Showing Springs and link members. 
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Changing the colors and drawing size of springs can be performed by using the  

from the Material tree or from the Structure browser Spring tap, as show in Figure 6-7 

and Figure 6-8. Also, the drawing sizes can be changed by using the properties of 

the object at the springs, as shown Figure 6-9. 

 

 
Figure 6-7 Material Properties – Changing Color 
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Figure 6-8 Structure – Changing Color and Size 

 

                           Figure 6-9 Properties browser – Spring Size 

6.3 Boundaries 

Boundaries are surfaces within the simulation that are used to confine the movement 

of elements in the analysis to a more realistic setting. For example, the ground on 

which a structure is built is usually modeled as a bottom boundary. The use of 

boundaries reduces analysis time and optimizes your results. While they are only 
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set when defining a problem in the ELS Modeler, in the ELS Viewer, you can still 

change their display settings. 

To change boundary colors or transparencies, use the Color Settings dialog box 

explained in Section 5.4. To show or hide any boundary, use the Problem Features 

menu or Boundaries toolbar to toggle the display of all ( ), front( ), back( ), 

right ( ), left ( ), top ( ), bottom ( ),and irregular ( ),boundaries and wire 

frame mode ( ). 
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7 Viewer Advanced Options 

This chapter discusses different indicators used to display advanced ELS solver 

results such as: 

 Velocity Vectors 

 Contacts 

 Spring State 

 Blast Surfaces 

It also explains how you can animate the simulation and understand how to use the 

Control Bar.  

7.1 Velocity Vectors 

Velocity vectors are indicators of the direction and magnitude of element velocities. 

They are drawn as straight lines originating from element centroids towards the 

directions from which they are coming, as if they are element “tails”. As an element 

moves faster, its vector appears longer. Figure 7-1 shows how ELS displays velocity 

vectors for a group of elements affected by a blast.  

 

Figure 7-1Velocity Vectors 

To display velocity vectors for all elements in a structure, click the Show Velocity 

Vectors ( ) button or select the corresponding option from the Problem Features 

menu. To view the vectors for just some of the structural components, use the 

Structure browser, as explained in Section 3.1. 

Velocity vectors are only a visual representation useful for comparing the velocity of 

different elements or of the same element at different time instances. To know the exact 

velocity value of a certain element, use the Properties browser. 

 

 

You can change the drawing scale of the vectors, if they appear too short or too long, 

by using the Drawing Size Settings dialog box or the Velocity Vector toolbar (
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) directly. The Color Settings dialog box can be used to change their drawing 

color.  

7.2 Contacts 

According to the Applied Element Method, the ELS solver generates springs at 

interfaces between “touching” elements. If during the simulation, elements that 

were originally not touching happen to come in contact with each other or with 

boundaries, further springs are generated at these contact points (see the ELS 

Theoretical Manual for more details). You can view such points in ELS by clicking 

the Show Contacts button ( ) or by selecting the option from the Problem Features 

menu.  

At ELS V(8) Contacts appear as Cross(X) indicators at the elements. To show the 

contacts at the display window first use the Preferences then check Read Contact 

option as shown in Figure 7-2. Click on show contacts icon (  ) to select the contact 

types you need, as shown in Figure 7-3.  

 
Figure 7-2 Preferences – Read Contact 
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Figure 7-3 Show/Hide Contacts Settings 

Figure 7-4 shows an example of these indicators appearing when an 8-Node falls 

from one direction until it rests on a girder. For more clear appearance of Contacts 

you can show objects in wireframe mode as shown in Figure 7-5. You can change the 

default colors for any type of contacts by using the Preferences dialog box as 

Figure 7-2. Also, Contact size can be changed from the Drawing Size dialog box. 

The Show Contacts button is disabled by default unless there is one frame at least with 

existing contacts. If the ELS Viewer is opened while the solver is still running, you may 

need to click the Update Problem Data option from the Problem Features menu to enable 

the button if contacts are discovered by the solver.   
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Figure 7-4 Contacts Between 8-Node and Girder 
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Figure 7-5 Contacts between objects on wireframe mode 

 

 

 
Figure 7-6 Contact Size 
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7.3 Spring State 

This option shows the state condition of every spring at every frame. Click the 

Show State button ( ) to activate the Spring State option, then select which 

state you need to show as show in Figure 7-7 

 
Figure 7-7 Spring State 

Or use the Spring Properties as show in Figure 7-8 

 

Figure 7-8 Springs Properties 

 

 

Check more than one state will show only the springs which satisfied these states at the 

same frame.    
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7.4 Blast Surfaces 

When simulating blasts, ELS gives you many options for better viewing of the 

results. You can view blast surfaces and contours. This section discusses the Blast 

surfaces, while blast contours is explained in Chapter 9 together with other contour 

types.  

ELS Viewer is the highlighting of blast surfaces. When activated, this option 

highlights surfaces that are directly impacted by the blast pressure. Such surfaces 

are determined by checking whether an element centroid has a line-of-sight with the 

bomb center or not. If an element is partially exposed to the bomb, but not its 

centroid, it will not be highlighted as an element directly affected by the blast 

pressure. You can see the blast wave surfaces (front and side) when you click the 

drop down menu of the Show Blast- Related Data button ( ) or select the 

corresponding option (Show Blast -Related Data) from the Problem Features menu. 

Figure 7-9 shows an example of a blast surfaces. 

 
Figure 7-9 Blast Surface 
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 The solution time step should be small enough for both accurate results. 

 Side Blast surface will appear when user assign elements at side group of Custom 

Blast Load only. 
 

7.5 Animating Simulation Results 

Animating simulation results is one of ELS powerful features. It enables you to better 

visualize the simulation output. The ELS Solver produces output frames, each 

containing detailed information about all elements of the model at specific instances 

of time or at a specific loading increment. Viewing these frames one after the other 

in sequence produces realistic simulations of structural behavior, which you can 

capture as videos to better present output. (See Section 12.2 for more details on 

creating videos) 

To control the animation, use the Control Bar shown in Figure 7-10, which is located 

at the bottom of the screen. This bar can be used to control the animation of the 

following simulation results: 

 Structure deformation 

 Charts 

 Contours 

 Straining Actions diagrams 

By using this bar you can move through the output frames manually one at a time, 

whether forward ( ) or backward ( ). Another option is to play them 

automatically in sequence in forward ( ) or backward ( ) directions, and you can 

stop ( ) or pause ( ) the animation at any time.  

 

Figure 7-10 Control Bar 

If the animation is progressing too slow or too fast, use the spinner to 

increase or decrease the frame step. 
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The Control Bar slider indicates the animation progress, but it can also be used to 

access any frame quickly by dragging it right to advance or left to rewind. 

A fast and flexible way to navigate through different frames is by clicking the slider then 

scrolling the mouse wheel while keeping the mouse pointer hovering over the slider.  

In the right section of the Control Bar, there are five text boxes as shown in 

Figure 7-11  Control Bar text boxes. These boxes are show: 

 The number of the currently displayed frame. You can type a number to jump 

directly to a specific frame, and hovering over this box shows the total number of 

frames. 

 The time elapsed in dynamic stages. 

 The Cartesian coordinates of the mouse cursor location. 

 The number of selected element. 

 The number of selected springs. 

 

 

Figure 7-11  Control Bar text boxes 

 

If you expect the occurrence of a small deformation to a structure but cannot see it, 

increase the Displacement Scale Factor ( ) to magnify any displacement or 

deformation in the structure. Figure 7-12shows a beam with a displacement factor 

of ‘1’ on the left and with a much larger factor on the right to indicate the 

deformation which is otherwise unnoticeable. It is also possible to decrease this 

factor below ‘1’. 

 
Figure 7-12 Displacement Scale Factor 

In addition to animating the displacement or deformation in a structure, you can 

animate the drawing of charts as explained in Chapter 8. The use of the animation 

feature when viewing contours is discussed in Chapter 9. 
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8 Charts 

ELS enables you to plot charts which help you better understand and present 

simulation results. This chapter explains how you can formulate accurate and 

representative charts through discussing the following topics: 

 The different data types to plot 

 The steps for creating charts for any data type 

 Chart options at hand 

8.1 Plot table Data Types 

In ELS, you can choose to plot the data of any data type out of about thirty possible 

selections. Figure shows these various data types. You can choose any of them to be 

plotted on the horizontal axis (X-axis) or vertical axis (Y-axis) of a chart. 

Any data type can be plotted against time, which is more suitable for dynamic 

stages, or against loading increments, which is more suitable for static ones. If 

however, increments are used in dynamic stages, they act as counters for frame 

numbers, and in static stages, time is considered to be zero. Besides plotting against 

time or increments, it is also possible to plot data against other types of data. 
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Figure 8-1 Chart Data Types 

8.2 Creating Charts 

To create a chart, perform the following steps: 

1 - Click the New Chart Window button (  ) or select the corresponding option 

from the Charts menu. This displays the New Chart dialog box shown in 

Figure 8-2.  

 

Chart Data 
Types

Inctrement Data

Location

For elements 
and springs, 
profile of data 
such as force 
displacement 
and rotation 
can be drawn 
along a certain 
direction(X,Y,Z)

Elements

For elements, 
you can plot 
any one of the 
following 
varibles in the 
X,Y,Z direction 
or its total 
magnetude 
value:

- Displacement

-Rotation

-Force

-Moment

- Velocity

- Acceleration

- Kinetic 
Energy

Springs

for Springs 
you can plot:

-Stress

-Strain

-Force

-Relative 
displacement
for normal or 
resultant 
shear

- Tempreture 

Straining Actions

you can choose to 
plot one of the 
followin actions: 

-Normal

-Shear 2

- Shear 3

- Torsion

- Moment 2

- Moment 3

- Section Rotation 2 

-Section Rotation 3

- Resultant Shear

- Resultant Moment

Blast Pressure

You can 
Choose to plot 
the Blast 
pressure at any 
point,by 
defining its XYZ 
coordinates in 
space

OpenFOAM 
Pressure

You can 
choose to plot 
the 
OpenFOAM 
Pressure at 
any point by 
defining its 
XYZ 
coordinates in 
space

Time
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Figure 8-2 New Chart Dialog Box 

2 - Choose which data is to be represented on each axis. For example, to plot elements 

velocity component on the y-axis of the chart against displacement on the x-axis, 

make the selections shown in Figure.  

3 - After selecting the data to plot, click the Pick button. This hides the dialog box, 

enabling you to select the elements for which data is to be plotted. 

4 - Select the required elements by using the mouse or the Selection Range dialog 

box then press the <Enter> key to confirm the selection and return to the New 

Chart dialog box.  

5 - If you want to create a chart with all values absolute, select the Absolute Values 

check box.  

6 - Click OK to confirm your selection and display the requested chart. 

8.3 Basic Chart Options 

This section discusses the basic options for editing the appearance of the chart after 

it has been created. Each of the following options can be accessed either from the 

Chart window right-click menu or the Charts menu (in the next pages we will refer 

to them collectively as the “chart menus”). 
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8.3.1 Chart Data Options 

This group of options enables you to tailor the view of chart data to your needs:  

 To navigate the chart, use the panning and zooming commands in the same way 

they are used in viewing the structural model. 

 To update the chart data while the solver is running, choose the Update Chart Data 

option from the problem Feature update data setting. You can check the option of 

add new frames to Chart. Then run the Clip or use update data or Auto update 

 To switch the data represented by the X and Y axes, choose the Switch X-Y Axes 

option from the chart menus. 

 To change the scale limits of the chart axes, double-click on the axis to open the 

Axis Options dialog box shown in Figure 8-3. You can change the minimum and 

maximum values for each axis, by checking the limits option and setting the 

corresponding values. From this dialog, you can also set other properties of the 

selected chart axis, such as the axis title text properties. 

 

Figure 8-3 Axis Options. 

 By selecting any axis you can check/uncheck the Update vales option to update 

its limits while the solver is running shown in Figure 8-4. 
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8.3.2 Chart Display Options 

The following options enable you to modify the look of your chart: 

 To show or hide the chart legend, select the corresponding option from the chart 

menus. 

 To change the chart color or background color, show/hide grid lines and legend, 

and change the chart colors, do so from the Chart Options dialog box, as shown in 

Figure.  

 

 

Figure 8-5 Chart Options Dialog Box. 

 

8.3.3 Chart Series Options 

This group of options enables you to modify the representation of a single chart 

series, view its data, or add more series to already created charts. 

Figure 8-4 Update Value of the Axis 
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 To change the properties of a data series, select it from the chart or the chart 

legend, then choose Series Options from the right-click menu. The Series Options 

dialog box is displayed as shown in Figure. You can change the line style, 

thickness, and color from the Series Options tab.  

 

 

Figure 8-6 Series Options Dialog Box 

You can further distinguish the series appearance by adding markers, and setting 

their shape and color under the Markers table. Figure 8-7 shows a chart with a series 

marked with triangle shaped labels, and also it shows the Current Frame Indicator 

marked with blue solid circle. 

Hovering the mouse pointer near a marker displays its exact coordinates in a tooltip. 
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Figure 8-7 Using Markers in Charts 

 To view the data of this specific series, click the Series Data tab (This only enables 

you to view data. To export series data, see Section 8.4). 

 To delete a series, select it from the chart, then select the Delete option from the 

chart menus or press the <Delete> key. 

 Calculate statistics in series data (maximum values, minimum values, average and 

standard deviation For X values and Y values as shown in Figure 8-8. 
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Figure 8-8 Using Statistics in Charts 

8.4 Advanced Chart Options 
This section explains the advanced options related to charts: 

 Exporting chart data. 

 Exporting Script and Run Script 

 Animating charts. 

 Differentiate and Integrate charts. 

 Creating frequency domain charts. 

8.4.1 Export Chart Data 

ELS enables you to export chart data for storage or for use within other programs. 

Chart data is exported in text file format. To export such a file, click the Export Chart 

Data button ( ) or select the corresponding option from the chart menus. This will 

export data for all series in the active chart. To export just one of them, select it first, 

then click the Export button. Note that this option is only enabled when viewing a 

chart.  
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8.4.2 Export and Run Script 

For any opened chart(s) user can export script from file menu and run this script 

at any time from tool menu as shown in Figure 8-9. 

 

Figure 8-9 Export and Run Script 

 

 

 

8.4.3 Chart Animation 

Chart animation is a feature that is very useful for understanding charts for cases of 

cyclic or dynamic loading. It does so by plotting data in real time while the 

simulation is in playback. To animate a chart, select the Animate option from the 

chart menus, then use the Control bar buttons to start, stop, or pause the animation. 

In addition to that Frame Indicator option add to the chart. You can check the Show 

Indicator option from chart properties. 

When the chart is displayed side-by-side with a view of the structure. Figure 8-10 

shows such a case, where strain in a spring at the mid-span of a girder is plotted as 

applied loading on the girder increases. You can notice the girder failing at frame 

number 11 in the structure view window and also in the chart window 

simultaneously. To view two windows side-by-side, use the cascading or tiling 

options under the Windows menu. Frame Indicator appears at the display frame, you 

can change the shape of the indicator.   

When chart animation is activated, you can export bitmaps of the chart at different 

frames. See Section 12.1 for more on exporting bitmaps. 

 

http://www.appliedscienceint.com/
http://www.extremeloading.com/


Extreme Loading® For Structures V9           Viewer Manual 

 

www.appliedscienceint.comꓲwww.extremeloading.com 102 

 
Figure 8-10 Animating Structure and Chart Side-by-side 

 

 

 
8.4.4 Differentiation and Integration 

For any plotting chart, you can differentiate or integrate some physical data to 

get other ones. Use the right click menu on chart area to get the Differentiation 

and Integration options as shown in Figure 8-11. For Example, drawing the 

displacement against time and differentiate the chart against time will give you 

the velocity. Also if you have the Pressure against the time you can integrate the 

chart against the Time to get the Impulse. 
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Figure 8-11 Differentiation and Integration options 

8.4.5 Frequency Domain 

If you are plotting data against time, you can further study its different frequency 

components. To do so, select the Frequency Domain option from the chart menus. This 

will change the axes to Amplitude versus Frequency using an FFT algorithm (for 

more information, refer to the ELS Technical Manual).Figure 8-12shows a time 

domain chart (displacement versus time) on the left and its corresponding resulting 

frequency domain chart on the right. Note the peak of the frequency domain chart 

indicating the principal frequency of the displacement change in time.  

If you switch to frequency domain, you can switch back to time domain. This can be done 

when you choose from chart menu time domain or frequency domain.  

 

 
Figure 8-12 Time and Frequency Domain Charts 
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9 Contours 

This chapter explains how you can use the ELS Viewer to better analyze simulation 

results through contour diagrams. ELS enables you to view four categories of 

contour diagrams: 

 Stress/strain. 

 Kinematics. 

 Blast contours. 

 OpenFoam Pressure 

To create a contour diagram, select the required category from the Contours menu 

or use the  buttoners provides a different dialog box for each contour category. 

The sections below explain the options in these dialog boxes in three groups: 

 Common graphical representation options. 

 Type-related options. 

 Advanced options. 

9.1 Graphical Representation Options 

All contour dialog boxes have a common part, shown in Figure 9-1, which enables 

you to set the options regarding the graphical representation of the contour. Each of 

these options is explained below in detail. 

 
Figure 9-1 Contours Display Options 
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9.1.1 Contour Shape 

Any contour diagram can be viewed as either Colored Lines or Colored Regions. This 

choice is made from the Shape options. The Colored Lines option only draws line 

contours, while the Colored Region option fills the regions between the lines. 

Figure 9-2 shows a column, girder, and slab structure with contour diagrams of the 

two shapes indicating total displacement under the effect of own weight. Both 

contour diagrams display the expected dishing effect for this load case where 

displacements are maximum near the center of the slab (blue) and minimum at the 

corners (red). 

 

Figure 9-2 Region and Line Contours 
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By default, when a contour diagram is drawn, a legend is displayed showing the 

colors representing different contour values as can be seen in Figure 9-3. You can 

hide or show the legend by clicking the  button from the Contours toolbar. Also 

in the toolbar is the Show/Hide Contours button (  ) which hides an already 

displayed contour when you click it, and redraws it if you click it once more. 

Another way to know contour values on the surface of a structure is by clicking the 

Show/Hide Contours Values button (  ). After clicking this button, when you click 

the mouse over any contour region, the contour value at this point will appear in the 

control bar at the bottom as shown in Figure 9-3. 

- The Show/Hide Contours Values option works best with Colored Regions contours than 

with Colored Lines, because with Colored Lines contours, it is difficult to hover your 

mouse pointer exactly over a single line.  

- Colored Regions contours present a heavier processing load on the computer when 

viewing them and may result in relatively slow responses while navigating large models. 

Switching to Colored Lines contours can help you navigate the structure smoother as it 

utilizes less processing resources. 

 

 

 
Figure 9-3 Viewing Contour Values and Legend 
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9.1.2 Contour Limits 

For any contour type, you have the option to set the limiting values of the contour 

diagram. By default, minimum contour values are colored blue and maximum 

values are colored red as shown in Figure and Figure 9-2. The limiting values can be 

set either manually or automatically. To set them manually, type the required values 

in the Min. Value and Max. Value textboxes. 

To calculate the limits automatically, click the Calculate Limits button. Specify the 

limits by typing the numbers of the first and last frames in the From Frame and To 

Frame fields. 

You can also select the scope of elements for which limits are calculated. There are 

three possible options as described in Table 9-1. 

Table 9-1 Scope of Elements on which Limit Calculation is Based 

Option Calculation of limits is based on… 

All Elements All surfaces of all elements. 

Outer Elements All surfaces of outer elements only. 

Outer Surfaces Visible surfaces of outer elements only. 

Selected Elements All surfaces of selected elements only. 

Note that surfaces having contour values outside the input limits range are colored 

white by default. This color can be changed by clicking on the Color of unavailable data 

box. 

When calculating limits automatically, it is advisable to click the Calculate Limits button 

shown in Figure 9-1 just before clicking OK, since limits are affected by most of the options 

in the contour settings dialog boxes.     

 

 

9.1.3 Contour Colors 

The graphical representation options shown in Figure 9-1also enable you to set the 

contour colors of your preference. By default, the color gradient of the contours 

shown in any of the contour settings dialogs is determined based on five colors 

which you can individually select. To change a color, right-click its corresponding 

arrow marker and select a color from the palette as shown in Figure 9-4. Intermediate 

colors in the gradient are automatically set based on these five colors.  

 
Figure 9-4 Changing a Contour Gradient Color 
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However, you are not limited to defining these five colors only. It is possible to 

remove any of these colors or add additional ones. To delete a color marker, right-

click and select the Delete option to remove it. Note that the color markers at the 

gradient edge cannot be deleted but only changed. 

To add a new color, right-click a location on the gradient as shown in Figure 9-5 then 

select Insert Indicator. Select the color of the new indicator from the palette. To restore 

the default color settings at any time, click the Load Default Colors button.  

 
Figure 9-5 Adding a Color to the Contours Color Gradient 

9.2 Contour Type-Related Options 
In addition to the common part present in all contour dialogs explained in 

Section 9.1, each dialog has options that are specific to its corresponding contour 

type. We mention these options below for each contour type.  

9.2.1 Element Stress/Strain Contours 

You can plot stress or strain contours for all elements. To display stress or strain 

contours, select the corresponding option from the Contours menu. The dialog box 

used to set stress or strain contours is displayed in Figure 9-6. There are three 

additional options in this dialog box together with the common graphical 

representation options: 

 Plot Type: in this section, you can select the contour value to be plotted, whether 

stress or strain. 

 Calculation Method: in this section, you can choose one of two contour calculation 

methods: Averaged or Non Averaged. (For more details see Section 9.3) 

 Plot Direction: in this section, you can choose the direction along which stresses 

or strains are to be calculated. (For more details see Section 9.3) 
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Figure 9-6 Elements Stress/Strain Settings Dialog Box 

 

 

 

 

 

http://www.appliedscienceint.com/
http://www.extremeloading.com/


Extreme Loading® For Structures V9           Viewer Manual 

 

www.appliedscienceint.comꓲwww.extremeloading.com 110 

9.2.2 Element Kinematics Contours 

Choosing to draw element kinematics contours opens the dialog box shown in 

Figure 9-7. In addition to the options controlling the graphical representation of the 

contours, which are explained in Section 9.1, this dialog allows you to specify the 

kinematic property to plot the contours for.  

First, you choose one of four kinematic properties to plot: displacement, velocity, 

acceleration, or rotation. For each property, you can either select its component in a 

specific direction or its total magnitude. For rotation, the direction selected is the one 

around which the rotation is calculated. You can also type in a Scale value. 

 

Figure 9-7 Element Kinematics Settings Dialog Box 
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Note that the contour limits do not adjust to the new normalized values until you press 

the Calculate Limits button.  

 

 

9.2.3 Blast Pressure Contours 

The Blast Pressure Settings dialog box, shown in Figure 9-8, does not include any 

additional options besides the graphical representation ones. It does not allow the 

selection of the element scope controlling the contour limits, since the blast pressure 

values are always calculated on the outer surfaces only.  

Note that for blast pressure contours, each element has only one value and therefore 

only one color. Hence, the user must choose to plot using Colored Regions Colored 

Lines will be meaningless. 

 
Figure 9-8 Blast Pressure Settings Dialog Box 
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9.2.4 OpenFOAM Pressure Contours 

The OpenFOAM Pressure Settings dialog box, shown in Figure 9-9, does not 

include any additional options besides the graphical representation ones. It does 

not allow the selection of the element scope controlling the contour limits. 

 

Figure 9-9 OpenFOAM Pressure setting 

9.3 Advanced Contour Options 

This section explains two advanced contour plotting options available when plotting 

stress or strain contours: the calculation method and the plotting direction of the 

contour.  

9.3.1 Contour Calculation Method 

From the Elements Stress/Strain Settings dialog box shown in Figure 9-6, you can 

select one of two contour calculation methods from the Calculation Method section: 

Averaged or Non-Averaged.  
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Non Averaged contours are based on individual elements exact values regardless of 

neighboring ones and hence may result in sharp changes in contour values across 

element boundaries. Averaged contours appear smoother and eliminate sudden 

changes in contour lines by averaging out values of neighboring elements(for further 

details on these calculation methods, see the Theoretical Manual).  

Figure 9-10 shows a stress contour drawn on the top surface of a column (having 5x5 

elements in its cross-section) using the two methods. The one on the left is that 

produced by the Averaged Calculation method. Notice its smooth and continuous 

contours.  

 

Figure 9-10 Averaged and Non-averaged Contour Calculation 

9.3.2 Special functions 

Adding special stress and strain functions as Von Misses yield criterion and 

Tresca yield criterion. 

9.3.3 Contour Plot Direction 

When plotting stress/strain contours, you can select the direction in which to 

calculate contour values and the planes on which you want them to be plotted. This 

can be done from the Plot Direction section shown in Figure 9-6. Choosing any of the 

three direction options displays additional options below it. The three cases are 

explained below: 

1 - To calculate the contour values along global or principal axes, select the Along 

Global Axes option. The options shown in Figure 9-11appear and help you choose 

the exact direction related to global or principal axes.  

 

Figure 9-11 Options for Calculating Contours along Global and Principal Axes 
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2 - To calculate the contour values along a custom vector, select its corresponding 

option from the dialog box to view the options shown in Figure 9-12. From this 

new set of options, you can define the vector either by specifying its direction 

ratios or by specifying two points along the vector. To specify the coordinates of 

these two points, you can type in their values directly or click Pick and select the 

points by using the mouse from the Viewer Window. 

 

Figure 9-12 Options for Calculating Contours along Custom Vectors 

3 - To calculate contour values on a cross-section, select the third direction option, 

Along Custom Plane, which displays the set of options shown in Figure 9-13. This 

option draws the contours on all areas of the model intersecting with a defined 

plane. In other words, they will be drawn on a cross-section of the structure as 

seen in Figure 9-14, not on its outer surfaces. The plane on which contour values 

are calculated can be parallel to the global axes or a general plane.  

 
Figure 9-13 Options for Calculating and Drawing Contours along Custom Planes 

Figure 9-14 and Planes show a column-girder structure under load, with stress 

contours drawn using the Along Custom Plane option at two sections (red being 

positive values of stress and blue being negative ones). 
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Figure 9-14 Normal-to-Plane Stress Contours at two Custom Planes 

 
Figure 9-15 Normal-to-Plane Stress Contours at two Custom Planes 
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For planes related to global axes, you can choose the X-Y, X-Z, or Y-Z plane together 

with an offset distance from this plane. To set a more general plane, you can specify 

the coordinates of 3 points on that plane or click Pick to select them by using the 

mouse. If the points are collinear, hence not enough to define the plane, or the plane 

does not intersect with the structure, warning messages appear. After defining the 

plane of the cross-section, you choose one of the two options for values to be plotted: 

Normal to Plane or Resultant Shear.  

 

Click the Calculate Limits button after defining the plane or axes to update limits based 

on new selection. In case of plotting contours along a custom plane, ELS automatically 

bases the maximum and minimum limits on values in this plane only not on all elements 

in the structure.      

 

Note that clipping a structure does not show contours on clipped surfaces. In fact, 

clipping does not show new surfaces while viewing contours. Figure 9-16 shows a 

girder clipped while displaying contours. Notice how it appears hollow and the 

contours on the other different sides are all visible. 

 
Figure 9-16 Clipping a Girder while Displaying Contours 
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10  Straining Actions 

One of the unique features in ELS is the ability to calculate staining actions and 

display them in the ELS Viewer. The Straining actions that can be displayed are: 

 The normal force. 

 The shearing force (two components and the resultant). 

 The bending moment (two components and the resultant). 

 The torsion moment. 

 Section rotation 

The Straining Actions can be displayed for: 

 The Entire Structure. In this case, straining actions diagrams are displayed in the 

Viewer Window for the whole structure. For more information, see Section 10.2. 

 A Single Component. In this case, straining actions diagrams for just one 

component are displayed in a separate dialog box. For more information, see 

Section 10.3. 

10.1 Selection of Components 

Components for which staining actions are calculated are classified into two 

categories; Automatic and Custom components. 

10.1.1 Automatic Components 

Staining Actions are calculated automatically by the ELS Solver for beams and 

rectangular columns, according to settings made from the ELS Modeler.  

Through the ELS Modeler, you can specify: 

 Whether or not to calculate straining actions for any individual element. This can 

be set from the ELS Modeler > Properties browser. 

 Whether to save straining actions data for the whole structure in output files or 

not. You can set this option from ELS Modeler > Preprocessing > Output Files 

Options. 

 The axes for calculating the straining actions. Select these axes from the ELS 

Modeler > Properties browser. 

10.1.2 Custom Components 

Custom components can be created by the user in the ELS Viewer to calculate 

staining actions for explicit steel section, Window,8-Node, wall and circle column 

components which generated automatically as custom component 

Although custom components allow the user more versatility in selecting the 

components for which to calculate staining actions, it takes more time to calculate 
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their values. It also requires more storage space to keep values which can be used to 

calculate the forces. 

 

10.2 Entire Structure Diagrams 

To view internal force diagrams and show or hide their envelope for all the structure 

or for any level, use the right-click menu of the Structure browser. The menu 

contains another sub-menu which has eight entries as shown in Figure 10-1. Short 

descriptions of the tree entries are given below: 

 Normal: Normal force in the structural component. 

 Shear2: Shear force in direction 2. 

 Shear3: Shear force in direction 3. 

 Torsion: Torsion moment. 

 Moment2: Bending moment about axis 2. 

 Moment3: Bending moment about axis 3. 

 Sec. Rotation2: Spring Rotation at the section around axis 2. 

 Sec. Rotation3: Spring Rotation at the section around axis 3. 

 Resultant Shear: Resultant of Shear2 and Shear3. 

 Resultant Moment: Resultant of Moment2 and Moment3. 

 

Figure 10-1 Structure Browser – Straining Actions Options 
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Selecting the check box next to any menu item displays the corresponding internal 

force diagram for the selected level or for the entire structure in the Viewer Window. 

Figure10-2 and Figure 10-3 show the normal force and bending moment diagrams 

for a three-story frame. By default, positive force values are plotted in red and 

negative values are plotted in blue.  

 
Figure10-2 Normal Force Diagram for a 3-Story Frame  

 

Figure 10-3 Bending Moment Diagram for a 3-Story Frame 
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- To view straining actions in the structure you need to hide all the elements of the 

structure to view the centerline on which the straining actions are displayed. 

- To animate the straining actions diagrams and see the effects of loads as they are 

applied, use the Control Bar at the bottom of the screen. 

- You can display more than one straining actions diagram at a time but each diagram 

will have a different scale. 

 

 

10.2.1 Display Settings 

To display the straining actions diagrams for only a selected number of components 

and not the whole structure, double click any of the Structure browser tree items. 

This displays the Structure Properties dialog box. Select the straining actions tab 

shown in Figure 10-4. From the components drop-down list, you can select specific 

structural components to display the straining actions for. This dialog box also 

enables you to: 

 Show/hide sections 

 Show/hide the envelope 

 Change the drawing scale 

 Change the color of straining actions and envelope diagrams 

 Show/Hide diagram text 

 Change the text color of straining actions and envelope diagrams 

 Display the diagrams with solid colors or hatched 

http://www.appliedscienceint.com/
http://www.extremeloading.com/


Extreme Loading® For Structures V9           Viewer Manual 

 

www.appliedscienceint.comꓲwww.extremeloading.com 121 

 
Figure 10-4 Straining Actions Dialog Box 

 

10.2.2 Displaying Envelopes 

You can view the envelope diagram for any straining actions simultaneously with 

the straining actions diagram itself. This section explains how to display an envelope 

diagram and set the range of frames for which the envelope is calculated.  

To display the envelope for a component, follow these steps: 

1 - Open the Straining action dialog box for the selected structural component, as 

explained in 10.2.1above.  

2 - In the Straining action data grid, select the Show Envelope check box as shown in 

Figure 10-5. 

3 - Click OK to close the dialog box and display the envelope. 
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Figure 10-5 Envelope Options (Straining action Tab) 

 

Figure 10-6 shows a frame with moving load applied to it and its bending moment 

diagram (B.M.D.) with envelope displayed in green. The moving load travels from 

the far-left of the beam to its far-right. The B.M.D. instance shown is when the load 

has covered approximately one-third of the distance, however, the envelope limits 

are calculated throughout the load trip.  
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Figure 10-6 Bending Moment Diagram with Envelope Displayed 

10.2.3 Setting Envelope Limits 

To set envelope limits for a certain component you need to do the following: 

1 - Open the Straining action dialog box for the selected structural component, as 

explained in 10.2.1 above.  

2 - Choose the component for which you wish to adjust envelope limits from the 

components drop-down list as shown in Figure 10-7.  
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Figure 10-7 Straining action Tab (Structure Properties Dialog Box) 

3 - In the Envelope Limits area, specify the envelope limits in frames or time (enabled 

if there are dynamic stages). Click All Frames to automatically fill the text boxes 

with the first and final frame numbers, as shown in Figure 10-8. 

 
Figure 10-8 Envelope Limits Area (Component Straining action Dialog Box) 

For custom components, it might take a lot of time to calculate the envelope values if the 

number of frames is large.    
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10.3 Single Component Diagrams 

This section explains how you can view all the internal force diagrams for a single 

component using the Straining action Details dialog box. the ways to display this 

dialog box, is select a component from the Viewer Window then view the Object 

properties in the Properties browser. Go to the Straining action section and select an 

item from the Components drop-down list, then click the details button as shown in 

Figure 10-9. 

 
Figure 10-9 Selecting a Component from the Properties Browser 

 

The above-mentioned methods all open the Component Straining action Details 

dialog box shown in Figure 10-10. This dialog box displays eight charts, one for each 

straining actions diagram for the selected component.  
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Figure 10-10 Component Straining action Details Dialog Box 

Moving the mouse pointer over any of the charts enables you to read the force value 

at this distance along the length of the component for all charts. A tooltip displays 

the distance of the location of the reading, and force value at that location.  

You can use the controls at the top-right corner of the dialog box to update the charts 

with data from different frames or animate the diagrams. Double-clicking any of the 

charts opens a magnified version of the chart as shown in Figure 10-11. Double-

clicking in the chart area once more restores the original view.  

 

Figure 10-11 Magnified Straining Action Chart – Moment3 
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10.4 View Custom Components 

In the Straining action Menu, you can find this option and you can reviews the 

custom components and their properties as in Figure 10-12 View Custom 

Components. 

 

 

Figure 10-12 View Custom Components 

 

 

http://www.appliedscienceint.com/
http://www.extremeloading.com/


Extreme Loading® For Structures V9           Viewer Manual 

 

www.appliedscienceint.comꓲwww.extremeloading.com 128 

10.5 Custom Components Diagrams 
This section describes the procedure for selecting custom components and then 

calculating their Straining action. Rectangular columns and beams structural 

components are automatically selected for internal force calculations. There are 

other components, however, that require the user to select them manually for 

Straining action to be calculated: 

 Circular columns 

 Walls 

 Slabs 

 Windows 

 8-Nodes 

 Explicit steel sections (see ELS Technical Manual for details) 

 Custom mesh components. Those with openings, variable mesh density, different 

materials, haunched beam, etc. 

To create a custom component, open the Straining action menu then select Add 

Custom Component. This opens the Add Custom Component dialog box shown in 

Figure 10-13. From this dialog box, you can: 

 Choose the calculation basis 

 Select the elements which constitute the custom component 

 Specify centerline direction and directions 2 and 3 

 Specify the number of sections at which forces are to be calculated 

The above operations are explained in this section together with how to load, delete, 

and save custom created components.  

 

Straining Actions calculations for automatically selected components are carried out by 

the ELS solver, while these calculations for custom components are carried out by the ELS 

viewer. Hence, it might take more time to display the forces for custom components in the 

viewer.   
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Figure 10-13 Custom Component Straining action Dialog Box 

10.5.1 Component Selection Method 

First, you need to select the elements that constitute the component. You can choose 

either to select elements or by window selection.  

10.5.1.1 Elements Selection:  

1 - Select the Elements option, as shown in Figure 10-14then click Next.  
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Figure 10-14 Elements Selection Method. 

2 - Select elements directly from the Viewer Window using the mouse. From the Add 

Custom Component dialog box, click Pick to select elements from the Viewer 

window then press the <Enter> key. Selected element IDs appear as shown in 

Figure 10-15. 
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Figure 10-15 Direct Selection of Component Elements from the Viewer Window 

 

10.5.1.2 Window Selection 

1 - Select the Window option, as shown in Figure 10-16then click Next.  

 

Figure 10-16 Window Selection Method 

2 - Define a selection volume using two, four or eight points as shown in 

Figure 10-17volume is a cube which has all its sides parallel to the global axes.  
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Figure 10-17 Volume Selection Method. 

- Clicking the Calculate Vectors button identifies the component center line and lists 

elements which are partially or fully enclosed within the volume.  

- Volume selection methods utilize spring forces as the calculation basis. 

 

 

10.5.1.3 Object Selection 

3 - Select the object option, as shown in Figure 10-18then click Next.  

 

Figure 10-18 Select Object Method 
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4 - Define a selection object as shown in Figure 10-18. 

5 - Click Pick to select object from the Viewer window then press the <Enter> key. 

Selected object IDs appear as shown in Figure 10-19. 

 

Figure 10-19 View the Selected Method 

- Clicking the Calculate Vectors button identifies the component center line and lists 

elements which are partially or fully enclosed within the volume.  

- Volume selection methods utilize spring forces as the calculation basis. 

 

 

10.5.2 Calculation Basis 

When creating a custom component, you can choose that the Straining actions 

calculations be based on element surface forces or element spring forces. 

Spring force data is more accurate than surface force data (which is a compressed 

version of spring forces) but consumes more storage space and more time in 

calculations.  

- All automatic components are calculated by the solver using spring force data which 

is more accurate.  

- By default, only element surface forces are available for straining actions calculations 

by the viewer. This is due to spring force data taking much more disk storage than 

element surface forces. To base calculations on spring forces, you need to enable them 

by selecting the ELS Modeler > Output Files Options > straining actions Based on 

Spring Forces check box. 

 

 

At V8 in ELS Modeler, both spring and surface forces be stored in the output files, 

so all the options will be enabled. If one of these force data is not included in the 
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output files, its corresponding options will be disabled from the Component 

straining actions dialog box.  

You can choose the calculation basis from the options shown in Figure 10-20and 

available from the Add Custom Component dialog box.  

 
Figure 10-20 Calculation Basis Options 

10.5.3 Specifying the Centerline 

To define a custom component centerline, use the straining actions Vector area of the 

Add Custom Component dialog box shown in Figure 10-21. The normal force will 

be calculated in the direction of V1, which acts as the centerline of the component. 

Two vectors have to be specified, V1 and V2, while the third vector, V3, is 

automatically calculated from a cross-product of V1 and V2 (right-hand system). 

Clicking Adjust Vectors enables you to preview its values before closing the dialog 

box.  

 
Figure 10-21 Centerline and Sections Settings 

V1 and V2 can be defined automatically or manually. ELS can generate them 

automatically according to the location of the component elements in space. When 

element selection is made using the mouse from the Viewer Window, they are 

automatically set. When element selection is made using a cuboid container, clicking 

the Calculate Vectors button shown in Figure 10-21 generates the vectors. In all cases, 

you can still define the vectors manually by overriding the automatic values.  
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10.5.4 Section Number 

Sections are locations along the centerline where straining actions values are 

calculated. You can set the number of sections by typing an integer value in the 

Number of Sections text box, shown in Figure 10-21. 

Created custom components are added to the drop-down list in the Straining Actions tab 

shown in Figure 10-7. After creation, these components cannot have their settings edited. 

To make changes to these settings, you need to create a new component. 

 

10.5.5 Envelope Calculation 

As shown in Figure 10-22, in this step, you can select whether to calculate the 

component envelope for All components or specific one. If enabled, you can 

define the envelope limits either by frames or by time (By time is enabled if there 

are dynamic stages). Also you can check Show/Hide All to show all Envelops. 

 

Figure 10-22 Envelope Calculation Options 
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10.5.6 Loading, Saving, Viewing and Deleting Custom Components 

When a simulation results file is closed, all custom component information is lost. 

To keep the components you define, you can save them before closing ELS then load 

them when the file is opened at another time.  

To save or load custom components, open the Straining Actions menu then select Save 

Custom Components or Load Custom Components. 

To delete a custom component, open the Straining Actions tab in the Structure 

Properties dialog box shown in Figure 10-7, select the component from the 

components drop-down list then click the Delete button.  
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11 Eigen Analysis 

This chapter explains the use of ELS in viewing structural vibration (Eigen) analysis 

results. The results of such an analysis can be accessed through the Eigen Window 

which you can open by selecting Tools >New Eigen Window. In this Eigen analysis 

window you can: 

 View and animate vibration mode shapes (Eigenvectors) 

 View vibration frequencies or periods (Eigenvalues) in both table and chart forms 

The New Eigen Window option is only enabled if you request an Eigen analysis from the 

ELS Modeler before running the solver. This can be done by specifying the number of 

Eigen modes to be analyzed in the ELS Modeler > Preprocessing > Output Sets dialog box. 

 

11.1 Viewing Vibration Mode Shapes 

Figure 11-1 shows the Eigen Window and its different components. The mode shape 

view area is where you can view and animate the vibration mode shapes of the 

structure. In this area you can navigate the view by using the zoom, pan, and 3D 

view controls in the same way explained in Chapter 4. 

 

Figure 11-1 Eigen Window 

The Frequency/Period Table lists the Eigen values for each mode at each time or 

frame instance. To view a specific mode shape at a certain time instance, click the 
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corresponding table cell. For example, to view the fourth mode shape at frame 14, 

click the table cell indicated in Figure 11-1.  

 

From the Eigen Window Options, you can animate the vibration mode shape by 

clicking the Animate button and if the displacement of structure elements is small, 

you may increase the Displacement Scale Factor.  

Changing the displayed Eigen mode from the table updates both the mode shape 

and chart areas. Figure 11-2 is a demonstration of the different vibration modes 

calculated by ELS for a five-story building.  

11.2 Charts for Vibration Frequencies and Periods 

The chart area at the bottom right of the screen is used to plot the vibration 

frequencies (or periods or mass participation factor) versus time (or increment). You 

can also select what each axis represents from the Eigen Window Options. Selecting 

Period or Angular Frequency or mass participation toggles the values in the table and 

modifies the chart Y-axis.  

The chart in Figure 11-1for example, shows that there is a reduction in structural 

vibration frequency due to stiffness deterioration resulting from applied loads to the 

structure. All chart options explained in Chapter 8 apply to this chart area and can 

be accessed from the right-click menu including switching axes, exporting chart 

data, differentiate, integrate and many others.  
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Figure 11-2 Different Vibration Mode Shapes for a Five-Story Building 
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12 Exporting Output 
This chapter explains how bitmaps, videos, DXF, Obj, STL file formats, Element 

Geometry and Script From Opened Chart can be exported from ELS. It also discusses 

the use of markers in exported bitmaps and videos. 

12.1 Exporting Images 
The bitmap export feature in the ELS Viewer is a useful tool that you can use to 

export information from your simulation results and to better present output. 

Although you can use external screen capture programs, exporting screenshots by 

using the ELS bitmap export tool is easier and faster. 

Export Bitmaps is a built-in screen capture tool with the following additional useful 

features, enabling you to: 

 Automate the process of getting screenshots and file naming for multiple frames, 

which saves time.  

 Select whether to include the whole workspace (all open windows, toolbars, and 

browsers) in the bitmaps, or capture the viewer window only instead of having to 

manually crop it from a full screenshot.  

 Choose to add the ELS logo to your output.  

To obtain screenshots in the ELS Viewer, click the Export Bitmaps button ( ) or the 

corresponding option from the File > Export submenu. You will be prompted for a 

filename and destination path for the bitmaps. For each individual frame captured, 

ELS automatically appends a sequential number to the filename. For example, if you 

type <capture> as a filename, the output files will be 

capture00001.bmp,capture00002.bmp, and so on.   

After choosing the filename and location, the Bitmap Export Options dialog box 

shown in Figure 12-1 appears. Under Frames, type the number of the starting and 

ending frames to be captured and the step between each frame and the next. 

http://www.appliedscienceint.com/
http://www.extremeloading.com/


Extreme Loading® For Structures V9           Viewer Manual 

 

www.appliedscienceint.comꓲwww.extremeloading.com 141 

 
Figure 12-1 Bitmap Export Options Dialog Box 

In the Add ELS Logo area, you can choose whether to add the ELS logo to your screen 

capture or not. The Solid option adds it as an opaque shape while the Blend option 

makes the logo semi-opaque. You can choose to place the logo in one of the four 

corners of the bitmap. The white box represents the bitmap, and the smaller blue box 

represents the location of the logo. Click the required location in the white box to 

choose the logo’s location. 

The final option in the dialog box is the Capture Main Window check box. Select it to 

include all open windows, toolbars, and browsers. Clear it to include only the active 

viewer window in the capture.  

Figure 12-2shows two bitmaps exported from ELS with different settings. On the 

left, the logo is included as a semi-opaque shape on the lower-right corner of the 

bitmap and only the Viewer Window is captured. On the right, the logo is semi 

opaque and is placed in the lower-right corner of the screen, and the whole viewing 

environment is captured by checking the Capture Main Window check box.  
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Figure 12-2 Examples of Exported Bitmaps 

12.2 Exporting Videos 

Exporting videos is a very powerful feature of ELS. It enables you to record videos, 

in AVI file format, of the model simulation with great flexibility. This is useful for 

presenting animated simulation results on computers that do not have ELS installed 

or for distributing results over the internet. You can also place markers in the video 

to pinpoint important events or to add text labels that appear at different times 

during the video (see Section 13 for more details).  

It is also possible to make a custom play, in which you have the ability to make  a 

video for certain frames as shown in figure 12-3. Before recording the video adjust 

the player settings to define the first recorded frame, last recorded frame and   

number of frame step. Click the Start recording button ( ) or the corresponding 

option from the File > Export submenu. You will be prompted for a filename and 

destination path of the video. After choosing the filename and location, the AVI 

Export Options dialog box shown in Figure 12-4 appears.  
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Figure 12-3 Player settings 

 

Figure 12-4 AVI Export Options Dialog Box 

In this dialog box, you can choose whether or not to insert the ELS logo in the video 

and whether or not to capture the entire program screen in the video, in a way 

similar to what was explained in Section 12.1 for the Bitmap Export Options dialog 

box.  

The two remaining options in this dialog, the Loop check box and the Frames per 

Second text box, are explained below. 

Clearing the Loop check box causes the video recording to stop automatically after 

reaching the final frame of the simulation. Selecting it will keep the video recording 

activated even if the animation reaches the end frame and restarts (loops) from the 

first frame. To stop the recording in this case, you will have to click the Stop recording 

button ( ).  
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The Frames per Second text box is used to set the number of frames to record in a 

single second of playback. The more frames per second, the smoother the video and 

the faster it plays.  

After setting all the options in this dialog box and clicking the OK button, the Video 

Compression dialog box shown in Figure 12-5 appears. This dialog box enables you 

to select the compression type for the exported video, which can help reduce the size 

of the video considerably.  

 
Figure 12-5 Video Compression Dialog Box 

Use the Compressor drop-down list to select a CODEC (Coder/Decoder). The 

CODECs in this list are not bundled with ELS, but are detected automatically by 

your operating system if they are already installed. The default selection is the Full 

Frames (Uncompressed), which exports the video without compression hence 

yielding large file size. 

It may happen that your operating system includes in the list CODECs that are not fully 

installed and hence not functioning. If you are unsure which CODEC to use, keep the 

default (Full Frames) selection. 

 

 

Some CODECs give you the option to set the Compression Quality of the video. Use 

the scroll bar to set this value in a range from 0 to 100, with 100 being best quality. 

Some CODECs also provide more control on the compression parameters and 

settings. You can adjust these parameters by clicking the Configure button. For 

information about a selected CODEC, like its version or creator, click the About 

button.   

Click the OK button to begin recording starting from the currently displayed frame. 

You can stop or pause the recording at any time by clicking the Stop ( ) or Pause (

)  buttons respectively.  
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12.3 Exporting DXF Files 

To export CAD files of DXF format, click  from the Export toolbar or its 

corresponding option from the File > Export submenu. When clicked, this button 

opens a dialog box which prompts you to select a destination folder and filename. 

ELS exports the DXF file right after you click the OK button. 

12.4 Exporting Element Geometry 

To export elements geometry, click option from the File > Export submenu> 

Elements Geometry. When clicked, this button opens a dialog box which prompts 

you to select a destination folder and filename. ELS exports a text files including 

number of elements with coordinates of each corner right after you click the OK 

button. 

12.5 Exporting STL and Obj Format 

To export the ELV surface mesh as STL and Obj format to handle them in other 

graphics programs.  

12.6 Exporting Script from Opened Chart 

For any drawn chart, you can export script from Export option. Then Press 

(Alt+shift+Q ) to run the script and import it again 

http://www.appliedscienceint.com/
http://www.extremeloading.com/


Extreme Loading® For Structures V9           Viewer Manual 

 

www.appliedscienceint.comꓲwww.extremeloading.com 146 

13 Markers 

As mentioned previously in Sections12.1 and 12.2, the ELS Viewer enables you to 

insert markers in exported bitmap and AVI files. You can use such markers to 

indicate important events or to display information during video playback. Figure 

shows an example use of markers where two columns to be removed are marked for 

the viewer to see before actually being removed.  

 

Figure 13-1 Example Use of Markers 

There are three types of markers: symbol, text, and image. Symbol markers are 

available in six different shapes: Circle(  ), Diamond (  ), Square (  ), Cross(  ), 

Plus Sign (  ), and Triangle (  ). Text and image markers, as their names simply, 

enable you to use text and figures as markers. Clicking the Insert Text Marker button 

(  ) opens a dialog box which prompts you for the text to display, and clicking the 

Insert Image Marker button (  ) opens a dialog box to choose the image file to insert 

as a marker.  

You can change the color and rotation of a marker, together with other properties in 

one of two ways, using the Markers browser or Properties browser. To use the 

Properties browser for that purpose, you will have to select the markers first by 

using the Select Markers button ( ). You can select multiple markers and change 

their properties all at once by using the Properties browser.  

The other method of editing marker properties is using the Markers browser. Some 

marker properties are common between all types and others are type-specific. 

Table 13-1shows the different properties that are available in the Properties browser, 

and their use.  
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Table 13-1Description of Marker Properties 

Property Description Notes 

Name Displays marker name. These properties cannot 

be changed. Layer Displays the layer to which the marker belongs. 

Shape Displays the marker type. 

Color Enables you to change the marker color. These properties exist for 

all marker types, and can 

be changed from both 

Properties and Markers 

browsers. 

Scale Enables you to change the marker size. 

From Frame number at which marker starts to appear. 

To Frame number at which marker ceases to appear. 

X, Y 

Coordinates of the marker location on the screen, 

with (0,0) being the top-left of the screen. To move 

the marker to a new position without having to enter 

the coordinates explicitly, click the ( ) button 

inside the X,Y field in the Properties browser. 

Rotation 
Enables you to rotate the marker by typing the 

rotation angle in degrees. 

Text Enables you to edit the marker text. These properties exist 

only for text markers, and 

can be changed from the 

Properties browser only. 
Font 

Enables you to change the text font in use. 

Image Displays the path of the source image file. These properties exist 

only for image markers, 

and can be changed from 

the Properties browser 

only. 

Width Displays the image width. 

Height Displays the image height. 

Background 

color 

Sets the background of the image. 
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